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Dorico 3.0.10 

7 October 2019 

Improvements 

Guitar tablature 

It is now possible to use the digits on the numeric keypad (if your keyboard has 
one) to specify fret numbers when inputting and editing tablature. 

Harp pedaling 

A new quick filter for harp pedal changes has been added: choose Edit ▶ Filter ▶ 
Harp Pedal Changes to select or deselect all harp pedal changes within the 
current selection. 

Issues resolved 
ID # Component Issue 

 Audio engine 
EastWest Play, UVIWorkstation and other VST 3 plug-ins that use PACE Anti-Piracy copy 
protection are no longer blacklisted by Dorico (Mac only). 

 Audio export 
Under rare circumstances, Dorico could crash when starting audio export. This problem 
has now been fixed. 

 Bar numbers 
Nudging bar numbers in Engrave mode with Alt+arrow keys now updates the score 
display immediately. 

 
Chord 
diagrams 

The line thickness for O and X symbols for open and unplayed strings at the top of a chord 
diagram now scales correctly when chord diagrams are drawn at very small sizes. 

STEAM-9777 
Chord 
diagrams 

Chord diagrams no longer appear larger than expected when enabling them in projects 
created in earlier versions of Dorico. 

STEAM-9784 Comments Comments no longer cause multi-bar rests to split. 

STEAM-9671 Condensing 
Tied notes and glissandos were often spaced more narrowly on condensed staves than on 
regular staves; this problem has now been fixed. 

STEAM-9704 Condensing 
Under rare circumstances, the presence of an octave line with an (impossible) negative 
duration could cause slurs not to appear in condensed staves; this problem has been fixed. 

STEAM-9749 Condensing 
It is now possible to edit or hide player labels that appear both above and below the staff 
at the same position without affecting the label on the opposite side of the staff. 

STEAM-9786 Condensing 
When player numbers are stacked vertically in staff labels for condensed staves, they are 
now stacked in ascending order rather than in the order they are assigned to voices. 

STEAM-9861 Condensing 
Music following an instrument change on a system where condensed staves are present is 
no longer incorrectly narrowly-spaced. 
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ID # Component Issue 

STEAM-9815 Flows 
When switching off Export layouts as separate files in the Export Flows dialog, Dorico 
resets the selection of layouts to be exported, ensuring that the full score will be exported. 

 Font styles 
Changing the font, size or style in Engrave ▶ Font Styles now always saves correctly, even 
if an item using that font style does not yet exist in the project. 

STEAM-9603 Guitar bends 
The position of the control points for guitar bends no longer jumps unexpectedly when 
releasing the mouse at the end of a drag operation in Engrave mode. 

STEAM-9603 Guitar bends 
If tied notes are set to be hidden in tablature, the target note for a release will still appear if 
Fret number appearance for release is set for it to show. 

STEAM-9758 Guitar bends 
The position of the endpoints for guitar bends relative to the stem side of beamed notes 
has been improved. 

STEAM-9760 Guitar bends The appearance of multiple simultaneous pre-bends in tablature has been improved. 

STEAM-9807 Guitar bends Guitar bends that cross a system break now draw correctly on both sides of the break. 

STEAM-9700 
Guitar 
tablature 

Notes with pre-bends are now assigned to the correct string by default. 

STEAM-9759 Harmonics 
Natural harmonics on grace notes no longer incorrectly extend to the following rhythmic 
note. 

STEAM-9764 Harmonics 
Changing the harmonic type from artificial to natural no longer sometimes results in two 
fret numbers being incorrectly shown in tablature. 

 Harp pedaling 
When a harp pedal change is hidden in the current layout, the pedals are now listed in the 
signpost in the correct order, i.e. D, C, B, E, F, G, A. 

STEAM-9891 Harp pedaling 
A partial pedal change consisting only of pedals on the left-hand side of the harp no longer 
incorrectly contains a line break between the first and subsequent pedals. 

 Licensing 
A problem with the Soft-eLicenser that causes some File ▶ Export options to be missing 
on some Macs has been resolved (Mac only). 

 Localization Tunings for fretted instruments are now translated in non-English versions of Dorico. 

 Lyrics 
Various fixes to the Edit Line of Lyrics dialog to improve handling for individual lyrics 
including spaces, and accented characters. 

STEAM-9778 Lyrics 
Nudging lyrics vertically in Engrave mode no longer moves by a different amount 
depending on how many lyrics of which kind are selected. 

 Navigation 
Navigating between system-attached items, such as rehearsal marks, in systems with 
multiple staves using the arrow keys in Write mode now works more reliably. 

 Note input 
Under rare circumstances, Dorico could crash when using undo during step-time input. 
This problem has now been fixed. 

 Note input 
Explicit rests are now always created when Force Duration is enabled during note input; 
otherwise, Dorico simply selects the appropriate existing implicit rest. 
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ID # Component Issue 

 Note input 
Double-clicking on a string in tablature to start note input now always shows the caret on 
the appropriate string. 

 Note input 
When confirming a popover, the focus is now explicitly returned to the score view, so that 
navigating around the music works as expected. 

STEAM-9639 Note input 
Advancing the caret with Space now correctly advances by the same amount when it 
spans multiple staves. 

STEAM-9799 Note input 
If the caret is already expanded across all staves, typing the up or down arrow key now 
resets the caret to span just one staff and navigates it between staves as normal. 

STEAM-9812 Note input 
The feature to retrospectively improve the enharmonic spelling of notes input via a MIDI 
keyboard was inadvertently disabled in Dorico 3; it now works correctly once more. 

STEAM-9843 Note input 
When inputting notes with multiple windows on the same project open, the score view will 
no longer try to follow the caret in inactive windows. 

STEAM-9846 Note input 
Starting note input from a selected barline or other system-attached item now shows the 
correct caret if the top instrument in the system is shown as tablature. 

STEAM-9781 Percussion 
When inputting multiple notes onto a percussion kit using a MIDI keyboard, playing 
techniques are now correctly created for the appropriate instrument. 

STEAM-9798 Percussion 
When moving through different instruments in the kit with the up and down arrow keys, the 
last chosen playing technique is remembered for each instrument during the input session. 

STEAM-9803 Percussion 
It is now possible to input rests onto a percussion kit using a MIDI keyboard if rest mode is 
active. 

 Performance 
Having the system track visible could result in occasional delays while moving the mouse 
around the score; this problem has now been resolved. 

STEAM-9882 
Playback 
templates 

Clicking Reset to Default in Play ▶ Expression Maps and Play ▶ Percussion Maps now 
resets back to the state defined in the current playback template. 

STEAM-9793 Play mode 
Long names for VST instruments that cause them to appear elided in the VST Instruments 
panel no longer cause Dorico to use excessive CPU or, in rare circumstances, freeze. 

STEAM-9810 
STEAM-9814 

Play mode 
It is now possible to change the port and channel correctly in the Chords track in Play 
mode. 

STEAM-9813 Play mode Edits made to the velocity of grace notes are now correctly respected in playback. 

STEAM-9822 Play mode 
If a project had been saved with a VST plug-in window open, and that plug-in is no longer 
available when the project is reopened, Dorico could hang. This has now been resolved. 

STEAM-9830 Play mode 
When enabling independent voice routing in Play mode, Dorico now always ensures that 
additional sounds are loaded for extra voices. 

STEAM-9831 Play mode 
The Duplicate button in the action bar at the bottom of the VST Instruments panel in Play 
mode now works as expected. 

STEAM-9833 Play mode 
Under rare circumstances, Dorico could hang when starting playback. This problem has 
now been fixed. 
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ID # Component Issue 

STEAM-9870 Play mode 
When independent voice routing is enabled, the display of automation lanes for each voice 
could get confused; this problem has now been fixed. 

STEAM-9885 Play mode 
When the Sends section is visible in the Mixer, it was not possible to start playback; this 
problem has now been fixed. 

STEAM-7799 
Playing 
techniques 

The Horizontal offset for text playing techniques option on the Playing Techniques 
page of Engraving Options works correctly once more. 

STEAM-9341 
Playing 
techniques 

Grouping a playing technique that shows a sim. continuation with a later playing technique 
no longer results in the sim. marking remaining in addition to the correct transition line. 

STEAM-9654 
Playing 
techniques 

If a playing technique continuing over a system break would be sufficiently wide that it 
would result in the line being unable to draw, the playing technique will not appear. 

STEAM-9709 
Playing 
techniques 

Under some circumstances, playing techniques drawn as repeated glyphs would not 
update correctly when editing or undoing edits to their notes. This has now been fixed. 

STEAM-9776 
Playing 
techniques 

Edits to factory playing techniques made in previous versions of Dorico are no longer 
unexpectedly lost when opening that project in Dorico 3 for the first time. 

STEAM-9804 
Playing 
techniques 

Deleting a bar or otherwise removing time from the middle of an ongoing playing technique 
now always correctly updates the duration of the playing technique. 

STEAM-9884 
Playing 
techniques 

When ungrouping one or more selected playing techniques, Dorico no longer crashes if 
the selection also includes an implicit rest. 

 Project files 
Under rare circumstances, Dorico could crash when opening a project created in an earlier 
version. This problem has now been fixed. 

 Project files 
Dorico no longer crashes when opening projects created in an earlier version in which 
instruments that have no set standard or advanced playable ranges are used. 

STEAM-9869 
Repeat 
markers 

A repeat marker, such as a segno, positioned at the start of the flow now appears as 
expected in galley view. 

 Setup mode 
It is now possible to drag an instrument from another player and drop it onto a section 
player in the Players panel, provided that section player is currently empty-handed. 

 Staff labels 
Clicking Reset to Default in the Edit Names dialog now also resets the state of the Show 
transposition option to its default value. 

STEAM-9789 Tablature 
If both staff notation and tablature are shown, lyrics now appear only on the regular 
notation staff. 

 Text 
Dorico no longer incorrectly reports that certain fonts are missing when opening projects 
created in earlier versions of the application. 

 Text 
When creating a new paragraph style, the font chosen by default will now reflect the 
choice for Default text font family in Preferences. 

STEAM-5536 Text 
Entering text into a frame from a master page with non-default properties (e.g. vertical 
justification, border) no longer causes those properties to be lost. 

STEAM-9829 Text 
When overriding the default choice of font for an existing font, paragraph or character style, 
if the weight requested by the original choice is not available, choose the Regular weight. 
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ID # Component Issue 

STEAM-9792 Tokens 
The resolved values for date and time tokens now follow the operating system’s regional 
and language settings (Windows only). 

STEAM-9799 Tokens All SMuFL codepoints are now correctly resolved from tokens.  

STEAM-9387 Tuplets It is once again possible to flip a tuplet number/bracket using Edit ▶ Flip. 

 User interface 
When migrating user settings from a previous installed version of Dorico, the migrated 
preferences are now used on the first run of the application, instead of needing a restart. 

 User interface 
When a modal child dialog opened via the Preferences dialog is open, it is no longer 
possible to close the Preferences dialog until the child dialog has been closed. 

 User interface 
The padding of the buttons in the Accidentals section of the Key Signatures panel in 
Write mode has been adjusted so that up to five columns of accidentals can appear. 

 User interface 
The Length field in the Expression Maps dialog now correctly saves and restores the 
value entered there, but it still currently has no effect on playback. 

 User interface 
The font menu in the Paragraph Styles and Character Styles dialogs once again appears 
as as a single scrollable list rather than as a cascading menu that fills the whole screen. 

 User interface 
When macOS Dark appearance is active, the background of the editor for accidentals, 
chord symbols, music symbols etc. is now white rather than black. 

 User interface 
When choosing a graphic to use as a music symbol or playing technique, the preview of 
the graphic is now constrained to the size of the panel. 

 User interface 
If you have changed project info values in Project Info but not yet applied them, copying 
info from the project to a flow will correctly use the updated values, not the old saved ones. 

 User interface 
It is now possible to set custom key commands for the pencil, line, erase, and percussion 
tools in Play mode on the Key Commands page of Preferences. 

 User interface 
When clicking e.g. Save as Default, the Close button in the options dialog will be 
disabled until the operation completes, to avoid a crash when closing while it is ongoing. 

 User interface 
The selection in the list of flows in the Project Info dialog is no longer unexpectedly 
changed when clicking Apply. 

STEAM-9722 User interface 
Attachment lines now always correctly appear for selected items; previously they could 
disappear if they were exactly axis-aligned. 

STEAM-9775 User interface 
The Pages and Master Pages panels in Engrave mode have been reworked so that 
scrolling them with a trackpad or mouse wheel is now much smoother. 

STEAM-9780 User interface 
Hitting Return in the Project Info dialog no longer causes a new flow to be added to the 
list of flows; instead, Return (like Tab) now advances through the text fields on the right. 

STEAM-9827 User interface 
Under some circumstances, Dorico could crash when showing a menu over a button in the 
Mixer or in the track headers in Play mode; these buttons have been reworked to solve this. 

STEAM-9863 User interface 
Changing the page margins for multiple selected layouts in Layout Options from Same to 
Different no longer results in a crash. 
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ID # Component Issue 

STEAM-9867 User interface 
Opening a project from Dorico Pro last saved in Engrave mode in Dorico Elements no 
longer shows incorrect properties in the Properties panel. 

STEAM-9048 Video 
Closing the Video window by clicking its close button no longer causes the video to fail to 
display when the window is subsequently re-shown. 
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Dorico 3.0 

2 September 2019 

New features 

Condensing 

When producing performance materials for a large ensemble, one of the 
challenges is producing a practical full score for the conductor. If each player’s 
music is written on its own staff, there might be dozens of staves that all need to fit 
into the limited vertical space provided by the paper size; even using a large-format 
paper size like A3 or Tabloid (11” x 17”), staves might end up as small as 3.5mm 
(0.14”), or around half the size of the staff on a typical instrumental part, which is 
too small to read comfortably. Even when hiding staves belonging to players who 
are not playing for a particular system, balancing legibility with the physical 
constraints of the paper can be very difficult. 

The usual solution to this is to produce a condensed conductor’s score, in which 
music for multiple players is shown on a smaller number of staves, achieved by 
assigning music for two or more players to a single staff. This is a complex editorial 
process: to ensure that it is always clear to the conductor how the music is split 
between the players sharing the staff, it should be written as clearly and 
unambiguously as possible. Among the tools experienced editors use to achieve 
this are changing the staff labels in the left-hand margin, adding numeric labels to 
individual entries to make clear which of the players assigned to the staff is playing, 
and, most crucially, ensuring that the music itself is written as clearly as possible. 

If the music is unison, i.e. the pitches and rhythms for all players assigned to the 
staff are identical, then it should be written as a single voice, appropriately labelled. 
If the music is in rhythmic unison, i.e. the rhythms for all players assigned to the 
staff are identical, but the pitches are not, then it should if possible be written as a 
single voice with two or more noteheads on the same stem, provided the notes for 
player 2 are always lower than player 1; if a note in player 2’s music is higher than 
a note in player 1’s music, then the music must be written on two stems. If the 
music is neither in melodic or rhythmic unison, then each player’s music must be 
given its own stem, and consideration given to whether the music crosses in pitch; 
if the down-stem voice often crosses above the up-stem voice, it may be clearer 
simply to write the music for these players on separate staves. 

These considerations become more complex when more than two players are 
involved: the number of possible combinations for the disposition of music for, say, 
four horns into a smaller number of staves is immediately far greater than the 
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possible combinations for just, say, two flutes. And, of course, since the texture, 
density and character of music changes over the course of a composition, 
sometimes changing very rapidly, the ideal solution for one passage of music will 
not be ideal for the next, so the way in which the music is distributed between 
staves will change over time. 

These and other considerations mean that the task of producing a condensed 
conductor’s score is, to reiterate, a complex and time-consuming one, leaving 
aside the not insignificant issue that typically music notation software offers little to 
no assistance with any part of the process. There is an entirely separate dimension 
of complexity associated with realising that editorial process of determining the 
ideal result in the software used to produce the performance materials. 

It is possible to produce the instrumental parts from a full score, and increasingly it 
is possible for even complex parts to be produced using linked or dynamic parts 
where the instrumental parts are part of the same project as the full score, meaning 
that revisions to one are automatically reflected in the other. However, as soon as 
there is a requirement to produce a condensed conductor’s score, it is impractical 
to produce both the full score and instrumental parts from the same project: the 
music must exist in at least two unlinked locations in the project: once in the staff 
that is the source of the instrumental part, and at least once more in other staves 
that are shown in the score. The music must be manually copied and pasted 
between or edited separately in these locations, reducing or entirely eliminating the 
benefits of having the full score and instrumental parts in the same project. The 
logistical challenges of managing a set of additional staves that can accommodate 
all of the required combinations for, say, four horns to be condensed throughout a 
large work are non-trivial. 

In this age of ever-shorter deadlines and ever-tighter budgets, the net result of the 
time-consuming nature both of the editorial decision-making that goes into 
producing a condensed score and of the practical challenges of realising those 
editorial decisions in music notation software is that it is increasingly rare for new 
works to be produced with condensed conductor’s scores. The consequence is 
that music is often performed from impractical, hard-to-read scores, an obstacle to 
the ideal connection between conductor and ensemble that must be overcome to 
produce a successful performance. 

The new condensing features in Dorico 3 aim to provide solutions to these 
problems, both in terms of providing assistance in the editorial decision-making 
process required to determine the clearest way for music to be distributed 
between staves, and in terms of reducing the practical and logistical issues 
involved in producing both a condensed score and individual parts from the same 
project. 
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The approach. Other commercial software has taken faltering steps towards 
providing partial solutions to these problems, but always from the point of view of 
producing individual instrumental parts from a score in which the user has 
produced the condensed result manually. The software has to make a 
determination about how the condensed music is intended to be distributed to the 
individual players, and as such it places significant constraints on how the music 
can be written in the score in terms of the use of voices, and when and where the 
use of those voices can change, and how the music can be displayed. The user 
must adapt not only their workflow, but also accept restrictions on how the music 
can be notated, in order to work within the limitations of the software’s ability to 
infer the correct result from the manually condensed music. 

Dorico comes at the problem from the other direction entirely: you as the user take 
the responsibility for writing the music for each individual player exactly as you 
would like it to appear, and Dorico takes the responsibility for determining the ideal 
condensed result. This is the only practical approach, since only if the music is 
written completely unambiguously and separately for each player can appropriate 
decisions be taken about how that music can be condensed. It also has the great 
benefit of providing the greatest possible reduction in the time and effort required 
to produce a conductor’s score, since there is no duplication of effort: you simply 
produce the parts you want the players to see, and leave the vast majority of the 
work in producing the conductor’s score to the software. The result is a profound 
increase in the practicality of producing a condensed conductor’s score. 

No software has attempted to solve these problems before in this way or to this 
level of sophistication, and there is an almost infinite complexity and variation in the 
way music can be notated. Many years of research and development work have 
gone into the condensing features that are introduced here in Dorico 3, but they 
represent only the starting point, and we not only have concrete plans for further 
development in these areas, but also look forward to the feedback from 
composers, arrangers and editors who will use these features to find ways that we 
can further enrich them to provide greater power and flexibility in future versions. 

The basics. Using Dorico’s condensing features is incredibly simple. The basic 
steps are: 

§ Write the music in the usual way, without thinking about the condensed score. 
§ Enable condensing in the full score once the music is written. 
§ Check the condensed score in page view, changing system formatting where 

necessary to change the disposition of music between staves. 
§ Make any necessary graphical tweaks in Engrave mode. 
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In outline, that’s all there is to it. But the next several pages will explore all of this in 
more detail. 

What can condense. When you enable condensing, Dorico automatically 
determines which instruments in the layout can be condensed, assigning them to 
groups. A group normally consists of solo players adjacent in the score (i.e. next to 
each other vertically in the layout) who play similar instruments, for example Flute 1 
and Flute 2, or Trumpet 1, Trumpet 2 and Trumpet 3. A group can contain a 
maximum of 16 players. 

Music will only be condensed if a single voice is active on the source instrument: if 
there are multiple voices active on the source instrument, it is impossible to 
produce an unambiguous condensed result. 

Solo players can be condensed, while section players currently cannot, with the 
exception of section players with vocal instruments (such as SATB voices in a four-
part choir). If a solo player holds multiple instruments, only the first instrument held 
by the player will be considered for condensing: when any instrument other than 
the first is active, that player will not be condensed along with the other instruments 
in its group. 

Only instruments that normally have a single staff can currently be condensed, so it 
is not possible to condense, for example, two harps or two pianos. Solo players 
with unpitched percussion instruments are also excluded from condensing; it is 
already possible to show their music in a more condensed form in the full score 
than their individual parts by choosing to show, say, a grid or five-line staff in the 
score. 

Section players are typically used for string sections and choirs. It would be 
unusual for, say, Violin I and Violin II to be condensed together as a single group, 
but when writing complex divisi passages, it would be useful for divisi writing to 
appear on a smaller number of staves in the full score layout than in the 
instrumental parts. This kind of condensing is not currently possible, but is planned 
for future releases. 

When writing for large wind and brass ensembles, you may typically choose to use 
section players where the part will be played by a large number of, say, clarinets. If 
you want to use condensing with these ensembles, you should use solo players 
instead for the time being. To move music belonging to a section player to a solo 
player, create a new empty-handed solo player in the Players panel in Setup mode, 
expand the card for the existing section player to reveal the instrument held by the 
player, and drag and drop it onto the new solo player. You can then remove the 
now empty-handed section player. 
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Typically, only alike instruments are condensed together, but there are some 
common exceptions: for example, in orchestral writing, trombone and tuba often 
share a staff; in choral writing, sopranos and altos often share a staff, likewise 
tenors and basses. Similarly, instruments are typically condensed in ascending 
numeric order, so when you have more than two players, they might be paired up 
as 1+2 and 3+4, but with certain instruments, typically horns, they may be paired 
in an interlocking fashion, e.g. 1+3 and 2+4. Instruments that are generically 
similar but have different transpositions, for example Trumpets in B♭ and Trumpets 
in C, will likewise not be grouped automatically. 

Dorico does not automatically produce these kinds of groups, but you can specify 
them yourself as custom condensing groups. You can also specify which 
instruments should not be condensed. These settings are made on the Players 
page of Layout Options, in the new Condensing section. 

 

Groups to exclude from condensing lists all of the automatically-generated and 
custom condensing groups for the current layout. To prevent a group from 
condensing throughout the layout, activate its checkbox in this list. 

Custom condensing groups lists any custom condensing groups you have 
created yourself. To add a new custom group, click the New Group button, which 
opens a simple dialog in which all eligible players are listed: select the instruments 
you want to be grouped, and click OK. Any players you add to a custom 
condensing group will, of course, be removed from any automatic groups to which 
Dorico had previously assigned them. 

You can also specify whether condensing is enabled for this layout by activating or 
deactivating Enable condensing. You can also enable or disable condensing by 
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choosing Edit ▶ Condensing; if necessary you can also assign a key command to 
this function on the Key Commands page of Preferences. 

Editing condensed music. When condensing is enabled, the music on condensed 
staves in page view is completely non-editable; like the music in cues, it cannot 
even be selected in Write mode. To help visually distinguish condensed music from 
non-condensed music, you can activate View ▶ Note and Rest Colors ▶ 
Condensed Music, which shows the notes and rests on condensed staves in grey. 

Condensing is not shown in galley view, so switching to galley view will show each 
player on its own staff, allowing you to input and edit their music as normal. You 
may even find it helpful to have two views on the same layout in the same window, 
by choosing Window ▶ Horizontal Split, and showing one view in page view and 
the other in galley view. 

Condensed music can be selected in Engrave mode, however, in order to allow 
you to make graphical tweaks to the placement of items like slurs, stems, beams, 
and so on. Properties set on condensed music are typically not reflected in the 
source music, so you can for example adjust the shape, placement and position of 
slurs without affecting the source music; however, if you change the line style of 
the slur from solid to dashed, say, that change will be reflected in the source music. 

Note input for condensing. If you habitually prefer to input music in short score – 
for example, you prefer to input the music for two flutes on a single staff as dyads 
and then explode it later on – this workflow can still be used, but you should of 
course explode the music before you enable condensing, as Dorico will not attempt 
to infer which music is intended to belong to each player: you must enter the music 
for each player individually. However, Dorico 3 also introduces some new tools to 
make inputting music for multiple players easier: you can now extend the caret to 
multiple staves by typing Shift+↑ or Shift+↓, and any music you input is either 
distributed between or duplicated on all selected staves. For more information, see 
Note input on page 64. 

How music is condensed. Many factors are considered when Dorico is 
determining how the music should be condensed. This includes determining 
chunks of music to consider together, and the constraints of how the music can be 
notated. 

Because the texture, density and character of music changes over the course of a 
piece, Dorico examines the music for each player in chunks, using an algorithm that 
crudely approximates the way music is divided into phrases. In simple terms, this 
means that Dorico will consider any run of notes without any intervening rests as a 
phrase, though phrases will be extended by any ongoing item that straddles a rest; 
slurs, ties, gradual dynamics, playing techniques, glissando lines, etc. will all cause 
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a phrase to be extended until the end position of all such ongoing items. These 
phrases are the indivisible units of condensing: Dorico will not change the way the 
music for a player is condensed within a phrase, though the way these phrases can 
be combined together can change, since phrases belonging to the different players 
in the group will often not start and stop at the same time. 

Once Dorico has determined the phrases for each player, it can then examine the 
possible combinations of these phrases to determine the optimal condensed result. 
Each condensed staff can show a maximum of two voices, one up-stem and one 
down-stem, though each stem may include music from multiple players. 

From most to least condensed, the possible results are: 

§ Unison: the pitches and rhythms for all players are the same within the phrase, 
producing a single stem with a single notehead. 

§ Shared stem: the rhythms for all players are the same within the phrase, but 
the pitches are not; but the pitches differ in such a way that the notes 
belonging to the player or players with higher numbers (i.e. Flute 2 has a 
higher number than Flute 1) are lower than the notes belonging to the player 
or players with lower numbers, producing a single stem with multiple 
noteheads, one for each player. 

§ Shared staff: neither the rhythms nor the pitches for all players are the same, 
but the music belonging to the player or players that will be written using the 
down-stem voice does not cross the music in the up-stem voice in pitch 
sufficiently often to make the music difficult to read. 

§ Not condensed: the rhythms are not the same, and the pitches of the music 
belonging to the players in the group cross too often to even be written on the 
same staff; this means that no condensation is possible, and the music will be 
written on separate staves. 

In order to produce a unison or shared stem result, the starts of phrases for the 
music to be written on the same stem must be at the same position. When music is 
written in two voices on the same staff, if the starts of phrases between the two 
voices align, and provided there are no other notations present that would make 
the result ambiguous, then notes in the down-stem voice that are the same 
duration as those in the up-stem voice and are lower in pitch can be amalgamated 
into the up-stem voice. This allows Dorico to use only one stem for the notes of the 
phrase where there is rhythmic unison, only breaking into the down-stem voice 
where the rhythms diverge. Dorico will not amalgamate notes within the span of a 
beam or a tuplet unless all of the notes in that span can be amalgamated. 

It must be understood that it is not only the pitches and rhythms of the notes 
themselves that are considered when determining the optimal condensed result: all 
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other notations are considered too, including articulations, dynamics, slurs, playing 
techniques, ornaments, and so on. For example, if the notes belonging to two 
players are unison and their phrases align, but they happen to be written with 
different slurs or dynamics, or with slurs of the same duration but conflicting 
properties, then the maximum condensation possible for that passage is for those 
two players to share a staff, with each player’s music written in its own voice, and 
with its own slurs or dynamics written on the appropriate side of the staff. 

One exception to this is clefs and octave lines: Dorico will allow instruments in the 
same group but written with different clefs, or music where one player has an 
octave line and another does not, to be condensed. The clefs and octave lines 
belonging to the first player in the up-stem voice will appear on the condensed 
staff, while clefs and octave lines from other players in the group will be omitted 
completely. The music for the other players will therefore be written on the 
condensed staff according to the clefs and octave lines belonging to that player. 

Music written for otherwise compatible instruments in different time or key 
signatures will not be condensed. 

Music is condensed system by system, moving from left to right. Because the 
condensed music may require different rhythmic spacing than the uncondensed 
source music – for example, when single notes a second apart on individual staves 
are written on a condensed staff, they will take up considerably more space 
because the resulting dyad includes a back-note – enabling condensing will often 
cause the casting off for the layout to change. Dorico will not change the 
condensation in the middle of a system, so a player cannot appear on one staff at 
the start of the system and then move to another staff midway through the system. 

However, condensation will often change from one system to the next, even if a 
phrase is ongoing; for example, it is possible for Trumpets 1 and 2 to be written in 
the up-stem voice on one system, with Trumpet 3 written in the down-stem voice 
on the same staff, but on the next system, the next phrase in Trumpet 3 crosses 
above the music of Trumpet 1 and 2, preventing Trumpet 3 from sharing a staff any 
longer. 

Beyond a handful of options (described below), you cannot currently influence the 
condensed result directly, though this is planned for future releases. For the time 
being, you can influence the result by inserting system breaks, because Dorico will 
respect any forced system layout and will then produce the optimal condensed 
result in can within the constraints of that fixed casting off. 

Notation Options. The new Condensing page of Notation Options provides some 
options that govern key aspects of Dorico’s decision-making for condensing, as 
follows: 
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§ Pitch crossing approach specifies whether Dorico should consider pitches in 
the down-stem voice crossing pitches in the up-stem voice as a factor in 
determining whether the players can share a staff; by default, Limit pitch 
crossing is chosen, which means that Dorico will not allow more pitch 
crossing within a range of aligned phrases than the value specified in 
Maximum number of pitch crosses in region, which is set to 1 by default. If 
you prefer to always allow players to share the same staff even when pitches 
cross, set Pitch crossing approach to Allow unlimited pitch crossing. 

§ Amalgamation approach specifies whether Dorico should be allowed to 
amalgamate notes from the down-stem voice into the up-stem voice. When 
the phrases in the up-stem and down-stem voices align but there is sufficient 
rhythmic divergence that it is not possible for the players to share a single 
stem, Dorico will by default amalgamate down-stem notes of the same 
duration as notes in the up-stem voice into the up-stem voice so that two 
voices are used only in those positions where the rhythms diverge. If you 
would prefer Dorico to consistently use two voices in these situations, choose 
Prevent amalgamation. 

§ Condensing for inactive players determines how players in the condensing 
group who are resting should be considered. There are three possible 
approaches: 
o Pair with active player will allow the inactive player to be assigned as the 

up-stem or down-stem voice on a condensed staff, with the other voice 
occupied by an active player, and the inactive player will show rests as 
appropriate.  

o Include in staff label will allow the inactive player to be silently assigned to 
the condensed staff, so that both the up-stem and down-stem voices are 
available for active players. The inactive player appears only in the staff 
label in the left margin. 

o Do not condense excludes inactive players from condensing for the 
affected region, so that the inactive player appears on its own non-
condensed staff. This option is useful if you choose to hide empty staves. 

Currently, Dorico will not condense multiple inactive players together into a single 
stem, so if you choose Pair with active player and have a condensing group 
containing multiple resting players, each inactive player will occupy a stem, 
meaning that a maximum of two inactive players can be assigned to a staff. Further 
options for this will be added in a future release. 

These options all apply to all condensing groups for the whole flow. In a future 
release it will be possible to change these options for each condensing group 
individually at any system break. 
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Labelling condensed music. In order to make it as clear as possible which players 
are playing at any given moment, Dorico both updates the staff labels in the left 
margin from system to system and adds player labels at points along the system to 
specify which players are included on the staff. 

At each point where the condensation changes, for example when a new phrase 
begins, Dorico will add labels above and, if appropriate, below the staff. If a single 
player is playing, a single number for that player is shown; if all players assigned to 
the staff are playing, a “to n players” label is shown, in the form e.g. a 3; if multiple 
players share a stem but one or more players is assigned to the other stem or is 
not playing, then the label will say e.g. 1.2 a 2, making clear which players are 
currently assigned to the stem. 

Options for player labels are found on the new Condensing page of Engraving 
Options. These allow you to change the default horizontal and vertical positioning 
relative to the staff, as well as to specify whether the numbers corresponding to 
players should be separated and appended with full stops (periods). 

You can nudge or drag player labels in Engrave mode and edit their text by 
activating the Custom text property in the new Condensation Labels group in the 
Properties panel. You can also hide an individual label by activating the Hide 
property in the same group. The final property is Line break, which can make 
player labels more horizontally compact by inserting a line break – for example, in a 
label like 1.2 a 2, the line break is inserted before a 2; in a label like 1.2, the line 
break is inserted between the two numbers. 

To change the font, style or size of player labels, edit the Condensation Labels 
paragraph style in Engrave ▶ Paragraph Styles. 

Staff labels. In addition to player labels, two new options have been added to the 
Staff Labels page of Engraving Options that dictate how Dorico labels condensed 
staves. Player numbers for condensed players allows you to choose between 
showing the player numbers in a column to the right of the instrument name (Stack 
vertically) or to append them in a row after the instrument name (Stack 
horizontally).  

If you choose Stack vertically, the exact arrangement of the player numbers will be 
determined by the adjacent option, When stacking player numbers for 
condensed players vertically: choose Consider stem allocation if you want 
Dorico to put the player numbers corresponding to the up- and down-stem voices 
on the staff in the same row (e.g. 1.2 instead of 1 above 2), or choose Ignore 
stem allocation if you always want a single column of player numbers, without 
considering which players are allocated to the up- or down-stem voices on that 
system. 
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When you have multiple condensed staves for similar instruments, the Staff labels 
for identical adjacent solo instruments option also takes effect; choose Group 
between staves to center e.g. “Flutes” between two condensed staves, which are 
themselves numbered as “1.2” and “3”. 

Handling of different items. Beyond notes, Dorico has to determine how other 
notations are handled when condensing music. Generally speaking, notations need 
to match – in position, duration, and appearance – across all players in the group if 
a unison or shared stem condensation is to be produced. If they do not match, it is 
typically still possible for the players to share a stave, but they must be notated in 
separate voices. A couple of notations, however, prevent condensing altogether. In 
summary: 

§ Arpeggio signs. These will only allow a shared stem to be produced in the 
case of unison chords in all source players.  

§ Articulations. Articulations must match on all source players to allow a unison 
or shared stem condensation; if any articulation does not match, the maximum 
possible condensation is a shared staff. 

§ Bar repeats. Bar repeat regions will allow condensation provided their 
position, duration and repeat bar count type match for all source players. If 
they do not match, the players cannot share a staff. 

§ Beams. Beams are considered when determining whether unison or shared 
stem condensation is possible; if the rhythms are identical but the beam 
groups differ, then the maximum possible condensation is a shared staff. 

§ Chord symbol regions. Chord symbol regions from the first player in the up-
stem voice will appear on the condensed staff; regions belonging to any other 
player will be omitted. Chord symbol regions do not limit the maximum 
possible condensation result. 

§ Clefs. Clefs from the first player in the up-stem voice will appear on the 
condensed staff; clefs belonging to any other player will be omitted. Clefs do 
not limit the maximum possible condensation result. 

§ Cues. Cues do not appear on condensed staves, and do not limit the 
maximum possible condensation result. 

§ Dynamics. Dynamics are considered when determining whether unison or 
shared stem condensation is possible; if the dynamics differ, then the 
maximum possible condensation is a shared staff. The placement of dynamics 
is overridden on condensed staves with two voices, so that they can be more 
clearly associated with the up-stem or down-stem voice. Dynamics are 
considered group by group, so if you have two otherwise identical groups in 
which only one dynamic differs, each dynamic group will appear on either side 
of the staff.  
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§ Glissando lines. Glissando lines are considered when determining whether 
unison or shared stem condensation is possible. If the glissando lines differ, 
the maximum possible condensation is a shared staff. 

§ Grace notes. Grace notes are subject to the same rules as rhythmic notes, 
and are considered when determining whether unison or shared stem 
condensation of the associated rhythmic notes is possible. If the grace notes 
differ, the maximum possible condensation is a shared staff. 

§ Guitar bends. Guitar bends are considered when determining whether unison 
or shared stem condensation is possible. If the bends differ, the maximum 
possible condensation is a shared staff. 

§ Holds and pauses. Fermatas and caesuras are system-attached items and do 
not limit the maximum possible condensation result. The position of breath 
marks on all source staves must match; if they differ, the players cannot 
condense. 

§ Jazz articulations. Jazz articulations are considered when determining whether 
unison or shared stem condensation is possible. If the jazz articulations differ, 
the maximum possible condensation is a shared staff. 

§ Key signatures. If key signatures differ between the source players, they 
cannot condense. 

§ Lyrics. Lyrics are considered when determining whether unison or shared stem 
condensation is possible. If they differ, the maximum possible condensation is 
a shared staff. The current approach to handling lyrics is simplistic, and does 
not account for lyrics whose effective duration is identical but whose actual 
duration is different (for example, a pair of passing notes versus a single note), 
resulting in lyrics being shown both above and below the staff more often than 
is ideal. 

§ Octave lines. Staff-attached octave lines from the first player in the up-stem 
voice will appear on the condensed staff; octave lines belonging to any other 
player will be omitted. Voice-specific octave lines, by contrast, will prevent 
condensation altogether.  

§ Ornaments and trills. Ornaments and trills are considered when determining 
whether unison or shared stem condensation is possible. For trills, both the 
duration and the effective interval is considered. If the ornaments differ, the 
maximum possible condensation is a shared staff. 

§ Rhythm slash regions. Rhythm slash regions cannot currently be condensed, 
and any player with a slash region cannot be condensed for that duration. 

§ Slurs. Slurs are considered when determining whether unison or shared stem 
condensation is possible. If the position, duration or line style of slurs differ, 
the maximum possible condensation is a shared staff. If, on the other hand, the 
slurs belonging to all players are identical, then Dorico will amalgamate the 
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slurs so that only a single set of slurs appears on one side of the condensed 
staff. 

§ Text. Text items are considered when determining whether unison or shared 
stem condensation is possible. If the placement or content of text items differ, 
the maximum possible condensation is a shared staff. 

§ Ties. Ties between voices – including ties from grace notes to rhythmic notes 
– cannot currently be condensed. They do not prevent condensation, but they 
will not appear on the condensed staff. More generally, ties within a note in a 
single voice are considered when determining whether unison or shared stem 
condensation is possible: if a note’s duration has been overridden by Force 
Duration, then it will only be allowed to share a stem if all notes on the stem 
have been overridden in the same way. If the ties or rhythmic offsets differ, the 
maximum possible condensation is a shared staff. Laissez vibrer ties will 
appear in condensed staves, and if they differ between the source players, the 
maximum possible condensation is a shared staff. 

§ Time signatures. If time signatures differ between the source players, they 
cannot condense. 

§ Tuplets. Tuplets are considered when determining whether unison or shared 
stem condensation is possible. Not only the effective duration but also the unit 
and ratio must match. If tuplets differ, the maximum possible condensation is a 
shared staff. 

System-attached items – tempos, rehearsal marks, markers, chord symbols, and 
repeat endings – all appear on condensed staves if appropriate, as determined by 
the options chosen on the Staves and Systems page of Layout Options. 

Because instruments with multiple staves are not condensed, pedal lines and harp 
pedal changes are not shown on condensed staves. Similarly, where an instrument 
has an extra staff or an ossia, those passages cannot be condensed. 

Troubleshooting. If you do not get the kind of condensation result you expect, there 
are a few things to check: 

§ Check that you are not unnecessarily using more voices than necessary on the 
source staves: use View ▶ Note and Rest Colors ▶ Voice Colors to check 
that all of the material is in the same voice. If it is not, select all the material and 
choose Edit ▶ Voice ▶ Change Voice ▶ Up-stem Voice 1 to move all of the 
music into a single voice.  

§ Check that the items you are trying to condense do not have conflicting 
properties. Notes with forced stem directions, forced durations, forced 
accidentals and so on will all limit the maximum possible condensation. Try 
selecting the affected music and choosing Edit ▶ Reset Appearance. 



 

 
Dorico 3 Version History Page 22 Steinberg Media Technologies GmbH 

If these tips don’t help, then please visit the forum and provide a minimal example 
of the problem you’re having, and the development team will be pleased to help. 

Future plans. Further improvements and expanded capabilities for condensing will 
be added in future releases. We welcome your feedback on the condensing 
feature in its current state, and invite you to visit the forum at 
www.dorico.com/forum to discuss the feature with the development team and your 
fellow users. 

Guitar tablature 

Dorico now provides tablature for guitar and other fretted instruments, including 
support for a number of idiomatic notations specific to guitar, custom string 
tunings, different conventions for representing rhythms on tab, and so on. One 
unique advantage that Dorico provides in this area over other notation software is 
that the music can be shown on a regular notation staff and in tablature at the 
same time, and an edit in one representation then automatically affects the other. 

Choosing the tuning. In order to be able to display tablature, Dorico needs to know 
how many strings the instrument has, the open pitch of each string, the number of 
frets, the starting fret (if a particular string starts beyond the nut, as the fifth string 
does on the banjo, for example), and the arrangement of frets (whether they 
proceed chromatically or diatonically, for example). 

When you assign a fretted instrument to a player in Dorico, if that instrument has 
several different commonly-used tunings, you will see the tunings listed in the right-
hand column in the instrument picker, allowing you to choose the desired tuning at 
the outset. 

Any fretted instruments in projects created in earlier versions of Dorico will 
automatically have the standard or most common set of strings and tunings 
associated with them when the project is first opened in Dorico 3. 

The quickest way to change the strings and tunings is to change that instrument to 
another instrument with the desired tuning. To change instrument, follow the 
procedure described in the Dorico Operation Manual here. 

Editing strings and tunings. A wide variety of tunings for the commonly-used 
guitars and other fretted instruments are included by default, but if you need to 
create your own tuning or modify an existing tuning, a dialog to do this is provided. 

In the Players panel in Setup mode, expand the card belonging to the player 
holding the fretted instrument whose tuning you want to change. Hover over the 
label corresponding to the fretted instrument such that the chevron > appears to 
indicate the presence of a context menu, then click to show the menu, and choose 
Edit Strings and Tuning. This dialog appears: 

https://www.dorico.com/forum
https://steinberg.help/dorico/v3/en/dorico/topics/setup_mode/setup_mode_instruments_changing_t.html
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The strings belonging to the instrument are shown in a simple graphical 
representation, with the open pitch of the string followed by the number of frets. 
Click any of the strings to enable the row of editing controls below the strings: 

§ Open pitch specifies the open pitch of the string: type this using the note 
name and octave (middle C = C4), using # for sharp or b for flat if necessary. 

§ No. of frets specifies the number of frets for this string; this can be set 
independently for each string if necessary. 

§ Starting fret specifies the number of the first fret on this string. In the picture 
above, the fifth string of the banjo is chosen, which starts at the fifth fret. 

§ The Tune Up Half-Step and Tune Down Half-Step buttons provide a quick 
way to tune the selected string up or down. 

§ Activate Irregular fret spacing if the fret arrangement for this string is not 
chromatic. Some instruments, such as dulcimer, have fretboards 
corresponding to a particular scale, so the distance between the frets may be 
either a half-step or a whole-step. Specify the fret spacing by typing 1 for a 
half-step or 2 for a whole-step in a comma-separated list. 

The Select All button allows you to quickly select all strings so that you can, for 
example, set the number of frets for all strings at once, or tune all of the strings up 
or down by a half-step. 

The action bar at the bottom of the dialog allows you to add, reorder or delete 
strings. Clicking Reset to Default will return the strings and tunings to the factory 
default settings for this instrument. 

Finally, you can click Export Tuning to export the current strings and tunings to 
a .doricotuning file that you can subsequently import to another instrument (either 
in the same project or in another project) by clicking Import Tuning. 

Showing tablature. To show tablature for a fretted instrument, go to the new 
Fretted Instruments section of the Players page of Layout Options. Each player 
holding at least one fretted instrument will appear there, with four options to 
determine how the music for the fretted instrument appears: 
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§ Notation, the default value, shows the music only on a regular notation staff. 
§ Tab shows the music only in tablature, and includes time signatures, stems, 

flags, beams, and so on, to show the rhythm of the music. 
§ Notation and Tab shows the music on a regular notation staff and in tablature 

below the notation staff; the tablature does not notate the rhythm, since the 
notation staff is included. 

§ Tab (no rhythms) shows the music only in tablature, but does not include 
time signatures, stems, beams, flags, and so on; this choice is only practical 
for music that is rhythmically very simple. 

Automatic string allocation. In order to display music in tablature, the string on 
which a note is to be played must be specified. Music that is entered in tablature 
directly naturally includes this information, but music that is entered in notation 
does not by default include any explicit string allocation, so Dorico performs an 
automatic allocation of notes to strings when no specific string has been set. 
Dorico will do its best to avoid allocating two notes to the string, unless they are 
unison notes in opposing voices. 

When two notes are allocated to the same string, they are shown positioned next 
to each other in tablature, colored green, so you can select either or both notes 
and make your own string allocation. Any impossible combinations – where two or 
more pitches cannot be played because the only possible locations on the 
instrument are on the same string – will be shown in purple. Normally in this 
situation you have no option but to delete one of these notes or otherwise change 
its pitch. 

Changing the string for a note. To move a note to the string above or below, select 
it and type N to move it to the string above, or M to move it to the string below. 
Dorico will not move a note to a string on which it cannot be played. You can also 
specify the string for a note by activating the String property in the Notes and 
Rests group of the Properties panel, which identifies the strings both by their index 
and their fundamental pitch (so, for example, the bottom string on a guitar in 
standard tuning is identified as 6 (E2), while the top string is 1 (E4)). 

Notes out of range. If a note is too low (i.e. below the nut on the bottom string) or 
too high (i.e. above the last fret on the top string) to be notated in tablature, it will 
be drawn off the bottom or top of the tablature as a question mark. You should 
change or delete such notes, or possibly consider altering the instrument’s tuning. 

Note input for tab. To input music directly in tablature, select a note or other item in 
the tablature and type Shift+N or Return to show the caret and start note input; 
you can also use the up and down arrow keys to navigate the caret from a notation 
staff into the tablature. 
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Notes are input by specifying the fret number to be played, which is done using the 
number keys, used for specifying the note duration when inputting onto a notation 
staff. When inputting a note beyond the tenth fret, simply type the two digits in 
quick succession: to change (say) a note you have just input on the first fret to the 
second, wait a moment before you type 2, and the existing note will instead be 
replaced. 

You can also play a note on your MIDI keyboard or type a letter name A–G when 
inputting tablature, and Dorico will input the note on the current string; when using 
alphabetic input, the octave closest to the nut will be chosen.  

Note durations can be specified either by clicking the desired duration in the left-
hand notes panel, or using the key commands = to choose the next longest note 
duration, or – to choose the next shortest note duration; when inputting onto a 
notation staff, these keys are used to specify sharp and flat accidentals. 

Chord input is effectively permanently enabled in tablature, so the caret does not 
move on its own: use up and down arrow to move the caret to the string above or 
below, and use left and right to move the caret to the previous or next grid position. 

Rhythms in tablature. When tablature is shown with no notation staff, it is usually 
helpful to notate the rhythms in tablature. This entails including items that are 
usually excluded from tablature, such as time signatures, and adorning notes and 
chords with stems, flags and beams, and optionally adding further adornments to 
disambiguate half notes (minims) and whole notes (semibreves) from quarter notes 
(crotchets). The relevant options are found on the new Tablature page of 
Engraving Options. 

Taking each of the sections of this page in turn: 

§ Stems: Different publishers and publications have different conventions for 
the notation of rhythms. For example, publications from Hal Leonard that show 
rhythms typically have stems pointing upwards by default, while the popular 
magazine Guitar World typically shows stems pointing downwards by default. 
(If two voices are active, stems will instead follow the direction dictated by 
their voice.) Likewise, stems in Hal Leonard publications typically only reach as 
far as the top string, so they are effectively shown only above or below the 
tablature, while stems in Guitar World reach into the staff, stopping shortly 
before the note on the lowest string. All of these conventions are easily 
accommodated using the options here. 

§ Rhythm Dots: Again, in Hal Leonard publications that show rhythms in 
tablature, rhythm dots are typically positioned outside the staff, at the inner 
end of the stem (choose Outside staff), while in Guitar World they are 
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typically positioned inside the staff, similar to their placement on a notation 
staff (choose Next to notes). 

§ Enclosures: Guitar World has popularized the use of elliptical enclosures 
around notes and chords that are longer than a quarter note (crotchet), since 
otherwise it is impossible to tell a quarter note and a half note (minim) apart. 
Guitar World uses elliptical enclosures (choose Ellipse), and Dorico also 
includes the more space-efficient option of using rectangles with rounded 
corners (choose Rounded rectangle). Other publications do not tend to 
differentiate between note values in this way, so by default no enclosure is 
used (choose None). 

§ Ties: Guitar World typically shows ties as dashed curves, while Hal Leonard 
publications tend to show them as solid curves, and either appearance is 
available by setting the Tie appearance option. There are also a number of 
different conventions about the extent to which ties are shown at all in 
tablature, and how tied notes after the initial attack are represented in tab; 
Dorico provides a comprehensive set of possibilities under the Tied notes in 
tablature option. 

Beams in tablature are always horizontal and have no slant, except for on grace 
notes. They follow the stem length options described above, with as many beam 
lines allowed inside the default stem distance from the outermost string as long as 
the inner beam line is not less than half a space from the outermost string. The 
stems are then lengthened by multiples of the beam’s thickness plus the gap 
between beam lines, so that additional beams appear above those for longer notes 
and everything lines up horizontally. 

Dead notes. Notes that are muffled, muted or deadened are known by a number of 
different names among guitarists, but in Dorico we have settled on the term dead 
note to cover this playing technique. Dead notes are shown using cross noteheads 
on a notation staff, and using an X in tablature. You can make any note show as a 
dead note by activating the new Dead note property in the Notes and Rests 
group in the Properties panel. 

Harmonics. Dorico now includes comprehensive support for the notation of 
harmonics, both for fretted instruments and more generally. See Harmonics on 
page 51 for more details. 

Properties for tablature. Many properties can be set independently for an item 
when shown on a regular notation staff and when shown in tablature, including 
almost all positioning and placement properties. 

Appearance of tablature numbers. To change the font, style or size of tablature 
numbers, edit Tablature Numbers Font in Engrave ▶ Font Styles. By default, the 
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numbers use the Lato Regular font at 8pt. The whole Lato font family (which is 
licensed under the SIL Open Font License) is now installed along with Dorico. 

Some publishers prefer fret numbers in tablature to have an erased background 
while others prefer the horizontal string lines to pass right through the numbers. By 
default, fret numbers have an erased background: to change this, deactivate Erase 
background around fret numbers on the Tablature page of Engraving Options. 

Scale factor for tablature. By default, the lines corresponding to each string are one 
and a half spaces apart, but if you want to change the spacing of the strings, you 
can do this on the Staves page of Engraving Options by adjusting Scale factor 
between staff lines in tablature. 

Vertical spacing for tablature. A new option Notation staff to tablature on the 
Vertical Spacing page of Layout Options allows you to determine the default 
distance between the notation staff and its associated tablature below. 

Clefs in tablature. Some publishers prefer that the tab clef appears only at the start 
of the first system in tablature. To achieve this, set the new option Show tab clef 
on to First System Only on the Clefs page of Engraving Options. 

Guitar bends and pre-bends 

One of the most idiomatic techniques in music for electric guitar is the bend and its 
relations, such as the pre-bend. Guitarists perform a bend by pushing the string 
out of its normal alignment, tightening it and thus increasing its pitch. The 
characteristic sliding sound of a bend is made by playing the note and then 
bending the string as it sounds. A pre-bend, on the other hand, involves bending 
the string before the note is played. The counterpart of the bend is the release, 
where the string is gradually allowed to return to its natural position. 

 

Bends, pre-bends and releases are all notated in the same way on staff notation: 
an angled line joins the start and end noteheads, positioned in a similar fashion to a 
slur, but using an angled line instead of a tapered curve. In tablature, however, 
bends, pre-bends and releases are notated differently, providing a more direct 
graphical representation of what happens to the string, with an upwards-pointing 
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curved arrow representing the bend and a downwards-pointing curved arrow 
representing the release; pre-bends are shown using a vertical arrow pointing 
straight upwards. 

Creating a bend or release. Bends and releases always join two notes. You can 
create a bend or release either by first selecting both the start and end note, or by 
selecting only the start note: provided there is another abutting note in the same 
voice immediately following the one you select, Dorico can automatically determine 
the end note. Bends are found in the Glissandi section of the Ornaments panel in 
Write mode, and can be created by clicking the angled line button there. 
Alternatively, you can type bend into the Shift+O popover to create a bend or 
release from the selected note; you don’t need to do anything different to create a 
release because Dorico automatically determines whether to create a release 
based on whether the end note is higher or lower than the start note. 

Dorico will create an angled line between the start and end note on the notation 
staff, and in tablature the end note of a bend will be hidden, with an upward-
pointing curved arrow labelled with a fraction for an interval or full for a whole step 
(tone) shown above its arrowhead. A release is shown with a downward-pointing 
curved arrow, arriving at the fret number for the end note. 

If your workflow involves creating many bends, you may find it more efficient to 
assign a key command to the new Create Guitar Bend command in the Note 
Input category of the Key Commands page of Preferences. 

Bend with hold. If a bend should be held for the duration of a tied note, sometimes 
a horizontal hold line is shown in tablature to show that the string should not yet be 
released. To do this, activate the Show hold property in the Guitar Bends group 
in the Properties panel. You can choose whether the hold should draw using a 
solid or dashed line on the Guitar Bends page of Engraving Options. 

Bend direction. On a notation staff, bends, releases and pre-bends are 
automatically positioned on the notehead side when only one voice is active; if 
multiple voices are active, they are instead automatically flipped to the stem side. 
You can also flip any selected bend or release by selecting it and typing F or 
choosing Edit ▶ Flip. Pre-bends cannot be flipped with F, but you can activate the 
Guitar pre-bend direction property to override their calculated direction. 

Creating a pre-bend. A pre-bend is created by activating the Pre-bend interval 
property in the new Guitar Pre-bends group in the Properties panel, and 
specifying the amount by which you want the string to be pre-bent. Defining a pre-
bend interval causes a parenthesized auxiliary note with a bend to appear on the 
notation staff, while in tablature a pre-bend is shown by way of a grace-note sized 
fret number with a vertical arrow showing the pre-bend interval above as a fraction, 
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or as the word full for a whole step (tone). If for any reason you want to hide the 
accidental shown on a pre-bend if necessary, activate the Accidental property in 
the Guitar Pre-bends group and set it to Hide. 

Engrave mode. You can edit the shape of every bend, release and pre-bend on 
both notation staves and in tablature in Engrave mode. On a notation staff, you can 
click and drag any of the three points of the angled bend line, or you can nudge 
any point with Alt+arrow keys; you can also type Tab to cycle through the three 
handles. 

In tablature, a bend also shows three handles: one for each end of the arrow, and a 
third control point that controls the shape of the curve. As with the notation staff, 
you can use the mouse or Alt+arrow keys to adjust any of the points, and type Tab 
to cycle between them. 

Bend intervals in tablature. If you would prefer to see 1 instead of full for a whole 
step (tone) bend, or if you would prefer to see 1/2 instead of ½ for a half-step 
(semitone) bend, change the relevant options on the new Guitar Bends page of 
Engraving Options. 

Release appearance. Different conventions exist for how the note at the end of a 
release should appear in tablature, since it is not actively struck by the player: some 
publications show the fret number as normal, some show the fret number in 
parentheses, and still others hide the fret number altogether. Set Fret number 
appearance for release to the desired appearance in the Design section of the 
Guitar Bends page of Engraving Options. 

Bends and rhythmic spacing. Dorico will automatically make room for bends on 
both notation staves and in tablature, and there are separate options for the 
minimum length of bends in each representation on the Guitar Bends page of 
Engraving Options. In some circumstances you may find that a bend arrow is a little 
narrower than you would like in tablature-only layouts, in which case you can either 
adjust the width of the bend arrow in Engrave mode, or manually increase the note 
spacing using the note spacing tools in Engrave mode. 

Combining bends with rhythms in tablature. If you want to show rhythms in 
tablature and also write bends, you are recommended to change Default stem 
direction to Down on the Tablature page of Engraving Options, so stems and 
beams and bends naturally appear on opposite sides. 

Playback of bends. There is no automatic playback of bends, releases or pre-
bends in this release of Dorico, but this is under consideration for future versions of 
the software. 
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Guitar chord diagrams 

Chord diagrams allow you to communicate a specific voicing for a chord to a 
guitarist in a compact and efficient way. In Dorico, chord diagrams are part of 
chord symbols and can be shown below a chord symbol on any player, and can 
reflect the tuning and string arrangement of any fretted instrument. 

 

A library of hundreds of chord shapes for 6-string guitar (in standard, dropped D, 
open G, open D and DADGAD tunings), ukulele, mandolin and banjo is included, 
providing a wide variety of voicings for many different chords. Dorico takes the 
novel approach of defining the chords not in terms of matching a specific 
combination of fingered frets at a particular position on the neck of the instrument 
resulting in a specific set of pitches, but rather in terms of a shape that is playable 
by a human hand and, provided any open strings can be stopped by way of a 
barre, can be moved up and down the neck. This allows the same shape to be 
reused for different chords – and even for different tunings for instruments with a 
compatible set of strings. 

When you edit or define a chord diagram, Dorico saves the chord shape rather 
than tying it to a specific chord definition, which means that if the shape can be 
moved up or down the neck, you will then see that shape offered to you for other 
chords, based on the pitches that Dorico calculates will be produced by applying 
that shape at different positions on the neck. 

Showing chord diagrams. To show chord diagrams, switch to Setup mode and in 
the Players panel, right-click the card corresponding to the player for whom you 
want chord diagrams to appear. In the Chord Diagrams submenu you will find a 
long list of the available fretted instrument tunings: choose the desired tuning, for 
example, Standard guitar tuning. 

Any existing chord symbols shown for this player will be updated to show a chord 
diagram below the chord symbol, and any chord symbols you create subsequently 
will also include a chord diagram. By default, Dorico will choose the simplest chord 
diagram for any given chord, meaning the chord symbol with the most open strings 
and with the fingered positions closest to the nut. 

If no suitable chord diagram is found in the library, an empty chord diagram will 
appear, and you will need to provide an appropriate shape: in Engrave mode, 
double-click the chord diagram to open the editor, described below. 
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Alternative shapes. For most chord symbols, there are multiple playable shapes 
included in the library. Select the chord diagram and type Shift+Alt+Q to open a 
simple dialog showing the shapes that are valid for the current chord symbol: either 
select the desired alternative shape with the arrow keys or the mouse, and hit 
Return or click OK, or simply double-click the desired shape to confirm the dialog. 
You can also cycle through all of the available alternative shapes directly in the 
score by typing Alt+Q with a chord diagram selected. 

The chosen shape will apply to all instances of the chord symbol at that rhythmic 
position for all players that share the same chosen fretted instrument tuning. 

Editing a chord diagram. If your preferred shape is not provided in the library, you 
can provide your own shape by switching to Engrave mode, selecting the chord 
diagram fragment of the chord symbol, and either double-clicking or hitting Return. 
The following editor opens: 

 

Each string can show a single dot, or the string can be open (showing an O at the 
top of the diagram) or omitted (showing an X at the top of the diagram). Click 
above the end of the string to cycle between omitted and open, or click on any fret 
on the diagram to move the dot there. 

If two or more strings are fingered at the same fret, you can show a barre between 
those strings by clicking on any of the dots at that fret position. Click again to 
remove the barre. 
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The pitch of each stopped and open string is shown above the diagram. If any 
pitch does not fit with the chord symbol associated with the diagram, that pitch will 
be colored red as a warning. 

To change the starting fret for the diagram, change the value of Starting fret in the 
action bar below the editor. To make the diagram show an additional fret, click +fr. 
in the action bar; similarly, to reduce the number of frets by one, click –fr. in the 
action bar. 

The checkbox Chord may be moved along the neck tells Dorico whether this 
chord is movable, or whether it is only playable at the position on the neck at which 
it has been defined. A chord is generally movable provided any open strings can be 
played with a barre if the chord is moved up the neck, but Dorico does not attempt 
to make this determination itself: you should set this checkbox as appropriate for 
your final shape. 

When you click Save, the chord shape is saved in the score and will be used for 
this chord diagram. Because of the way that Dorico stores chord diagrams by 
shape rather than with a fixed association to a specific chord symbol, this shape 
will then appear as an alternative choice for any other compatible chords. 

Root notes. Dorico provides a few options for preferences concerning root notes in 
chord shapes. If you are writing for a guitarist in an ensemble with a bass player, for 
example, you might want to choose voicings that omit the root note of the chord, 
since that will be played by the bass player. Options for this are found on the new 
Chord Diagrams page of Note Input Options, and allow you to specify whether 
the root should be omitted entirely, and whether or not it should, if included, be the 
lowest note of the chord. 

Chords with higher alterations. When writing chords with altered scale degrees of 
the ninth or higher, choices have to be made about which notes of the chord to 
omit. Options to influence Dorico’s decisions can be found on the new Chord 
Diagrams page of Note Input Options:  

§ Dominant sevenths or higher alterations: choose whether or not the fifth 
can be omitted. 

§ 11 and 13 chords: choose whether or not the ninth may be omitted. 

Chord diagram library. If you want to define many new chord shapes – for example, 
to define shapes for an instrument or tuning not already included in Dorico’s default 
library of shapes, you can choose Engrave ▶ Chord Diagrams. Choose the target 
tuning from the Tuning drop-down at the top of the dialog, which updates the list 
of shapes defined for that tuning, which are shown in the Chords drop-down. 
Define a memorable name for the chord shape you’re defining in the Name edit 
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control, then edit the shape as described above. When you’re done, click Save, 
and then either define a new chord diagram by typing a new name, or click Close 
to finish editing the library of chord shapes. 

Engraving options. The new Chord Diagrams page of Engraving Options provides 
control over every aspect of the drawing of the chord diagram, from line thickness 
and dot diameter to string and fret spacing. Possibly the most important option is 
Scale factor relative to chord symbol, which provides an easy way of changing 
the size of all chord diagrams. 

You can change the font, style and size of the fret number shown to the right of the 
chord diagram by editing Chord Diagram Fret Number Font in Engrave ▶ Font 
Styles. 

Guitar fingering 

Because of the technical complexity of performing the music, scores for classical 
guitar are often copiously annotated with fingerings for both the right and left 
hands. Dorico 3 includes comprehensive support for left- and right-hand fingering, 
with sophisticated automatic placement that produces results that are the equal of 
the finest published editions. 

 

Fingering popover. Guitar fingering is added using the Shift+F popover, and the 
popover shows L or R to indicate that you are inputting left- or right-hand fingering. 
To switch from L to R, type ↓; likewise, to switch from R to L, type ↑. 

Right-hand fingering commonly uses letters corresponding to the names of fingers 
in Spanish: p for pulgar (thumb), i for indicio (index finger), m for medio (middle 
finger), and a for anular (ring or third finger). There is less agreement about the 
initial for the little or pinky finger, and Dorico will accept c, e, x, or o. 

Left-hand fingering, meanwhile, simply uses numbers, with 1 for index finger and 4 
for the little or pinky finger (the thumb of the left hand is not usually used). 
Additionally, an open string is often indicated in the same way as a left-hand 
fingering, using the digit 0 (zero) rather than the letter O. 

If you have multiple notes selected, you can input multiple fingerings into the 
popover provided you separate them with comma; for example, select a chord of 
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three notes, then type Shift+F, type ↓ to switch to right-hand fingering, then type 
p,i,m to specify p for the lowest note, i for the middle note, and m for the highest 
note. 

For more information on how to use the fingering popover, consult the Operation 
Manual here. 

Appearance of right-hand fingering. Options for which letters should be used for 
the thumb and each finger of the right hand are found on the Fingering page of 
Engraving Options, in the Design section, under the Right-hand Plucked 
Fingering subheading. You can choose between p and t for thumb, and between 
no fewer than six different options for the little or pinky finger (e, q, c, s, o, x). 

By default, all right-hand fingering uses the traditional bold, italic look, but if you set 
Fingering appearance to Plain font, all fingering, including right-hand fingering for 
guitar, will use whatever font is set for the Fingering Text Font in Engrave ▶ Font 
Styles. 

Placement for right-hand fingering. By default, right-hand fingering is positioned 
outside the staff, on the notehead side, though in some editions, fingering for the 
right thumb is positioned below the staff instead. You can change these defaults by 
setting Default position of right-hand plucked fingerings and Default position 
of right-hand thumb plucked fingerings, in the Position section of the Fingering 
page of Engraving Options. 

Fingering for arpeggio signs. When using an arpeggio sign to show a spread 
chord, you may want to show which finger of the right-hand should be used to play 
all of the strings; such fingerings are shown at the bottom of the arpeggio sign. To 
add a fingering for an arpeggio sign, select the arpeggio sign and activate the 
Finger property in the Plucked Fingering group in the Properties panel. 

In the Position section of the Fingering page of Engraving Options, you will find a 
handful of options relating to the placement of fingerings for arpeggio signs, 
including Vertical position for arpeggio sign fingering, which allows you to 
specify whether the fingering should be allowed inside the staff or forced outside. 

Multiple strings picked by the same finger. It is common for multiple notes in a 
chord to be played with the same finger, often the thumb. This can be indicated by 
way of a vertical bracket spanning the common notes, with the fingering indicated 
below or next to the bracket. To achieve this notation, select all of the notes in the 
chord to be played by the same finger, and into the Shift+F popover, type ↓ to 
switch to right-hand fingering, then enter (say) p,p,p. By default, the fingerings will 
appear above or below the chord, but if you activate the Vertical position property 

https://steinberg.help/dorico/v3/en/dorico/topics/write_mode/write_mode_fingering_inputting_t.html
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in the Plucked Fingering group of the Properties panel and choose Next to note, 
Dorico will add the bracket and adorn it with a single fingering. 

Left-hand fingering. Left-hand fingering is typically positioned within the staff, to 
the left of the note to which it relates. This creates a good deal of complexity, 
because the fingering should not collide or even interfere with other items such as 
accidentals, rhythm dots, and so on. Dorico has the most sophisticated algorithms 
for the placement of left-hand fingering of any software, provides comprehensive 
options for placement, and, of course, allows you to tweak the positions of 
individual fingerings in Engrave mode if necessary. 

Appearance of left-hand fingering. By default, left-hand fingering uses the same 
traditional, bold appearance as keyboard fingering, but you can use any font of your 
choosing by setting Fingering appearance to Plain font in the Design section of 
the Fingering page of Engraving Options. When shown within the staff next to 
notes, left-hand fingering is smaller than fingering shown above or below the staff; 
the default scale factor is 85%, which can be found in the Advanced Options 
subsection of the Design section of the Fingering page of Engraving Options. 

In something of a departure from most published guitar music, by default Dorico 
erases the staff line to either side of left-hand fingerings shown next to notes in the 
staff to aid clarity. If you are a traditionalist and want to disable this, switch off 
Erase background behind fingerings inside the staff, also to be found in the 
Advanced Options subsection of the Design section of the Fingering page of 
Engraving Options. 

Placement for left-hand fingering. Several self-explanatory options controlling the 
horizontal and vertical placement of left-hand fingerings shown within the staff can 
be found in the Position section of the Fingering page of Engraving Options. 

To change the default placement of a specific left-hand fingering, activate the 
Stopping finger position property in the Fingering group of the Properties panel, 
which provides three options: Left of note, the default; Right of note, which 
moves the fingering to the right-hand side of the notehead; and Outside staff, 
which moves it outside the staff on the notehead side, or on the side of the staff 
corresponding to the voice’s direction if multiple voices are active. 

Fingering slides. To indicate that successive notes should be played by the same 
finger on the same string by sliding it up or down the neck of the instrument, an 
angled line is drawn joining the two fingerings, or, if the notes are particularly far 
apart, a shorter line is drawn to the left of the destination note. 

First, ensure that the String property in the Notes and Rests group of the 
Properties panel is activated and that the same string is set for both the source and 
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destination notes. Second, likewise ensure that the Finger or positions(s) 
property in the Fingering group of the Properties panel is set identically for both 
the source and destination notes. 

Once these prerequisites are satisfied, select the destination note and activate the 
Slide in property in the Fingering group of the Properties panel. If the two notes 
are sufficiently close, an angled line will be drawn between the fingerings. The 
fingerings themselves will not be moved, and instead the fingering slide will be 
drawn between the fingerings in their existing positions, avoiding any obstructions 
such as noteheads, accidentals and other fingerings that may be in the way. 

If you are not satisfied with the automatic placement of the fingering slide, try 
nudging the fingerings at the start or end of the slide in Engrave mode; the angled 
line will automatically follow the fingerings. If necessary, you can also select either 
end of the angled slide line itself and move it with the mouse or by holding Alt and 
using the arrow keys. To reset the position of the fingering slide, deactivate the 
Slide start and/or Slide end properties in the Fingering group of the Properties 
panel in Engrave mode. 

If the distance between the two notes is greater than the value specified for 
Maximum distance between notes to join with a fingering slide in the 
Fingering Slides section of the Fingering page of Engraving Options, the 
fingering slide will appear as an angled line of a fixed length immediately to the left 
of the destination fingering. You can override an individual fingering slide using the 
Slide type property, which appears in the Fingering group of the Properties panel 
in Engrave mode: set it to Join to draw the angled line between the source and 
destination notes, regardless of the distance between them; or set it to 
Destination only to draw a fixed-length line to the left of the destination note. 

Projects created in earlier versions. To avoid changing the appearance of fingering 
in projects created in earlier versions, if an existing project contains a guitar 
instrument or has fingerings, the new features for showing left-hand fingering 
within the staff and right-hand fingering outside the staff will not be enabled by 
default. If you find that left-hand fingering will only appear outside the staff and you 
cannot create right-hand fingering at all, go to the Fingering page of Engraving 
Options, and in the Advanced Options subsection of the Design section, activate 
Allow left-hand fingerings inside the staff for fretted instruments. Beware that 
this will change the position of any existing fingerings on guitar or other fretted 
instruments in your project. 

Guitar string indicators 

Competing with left-hand fingering for space within the staff are string indicators, 
which are normally shown in circles to either side of the relevant note, or on 
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occasion outside the staff, sometimes with a dashed extender line to show which 
notes should be played on the same string. 

 

String indicators above and below the staff can be created via the Shift+P 
popover by typing e.g. string1 or string3. 

String indicators shown to the left or right of the note are enabled by way of the 
Properties panel. With the note on which you want the string indicator to appear 
selected, activate the Show property in the new String Indicators group, and the 
string indicator will appear. If the String property in the Notes and Rests group is 
already set to an explicit value, the string number shown will reflect the choice 
there, but otherwise Dorico will display a calculated string number. If you intended 
a different string number to be shown, activate the String property and set it to the 
desired string number. 

Open strings. By default, Dorico shows a bold zero for an open string instead of a 
circled string number, but you can change this by setting Open string appearance 
to String indicator on the new String Indicators page of Engraving Options. 

Horizontal position. By default, Dorico positions string indicators to the left of the 
note provided no left-hand fingering is present, but if a fingering number is present, 
the string indicator will be switched to appear to the right of the note instead. 
Options to control this placement can be found in the Position section of the 
String Indicators page of Engraving Options. Further options are provided for the 
placement of string indicators for unison pitches in opposing voices. 

Harp pedaling 

The modern concert harp, which typically has a range of six and a half octaves, 
features a mechanical action that can raise or lower the pitch of its strings by a 
half-step (semitone), such that the harpist can play music in any key. The 
mechanical action is operated by way of pedals, each of which affect all of the 
strings of a specific pitch class across all octaves of the instrument. On the left 
side of the harp are three pedals (D, C, B), while there are four on the right (E, F, 
G, A). Each pedal has three positions: in its central position, the strings produce a 
natural, i.e. unmodified pitch; in its upper position, the strings produce a flattened 
(lowered) pitch; while in its lower position, the strings produce a sharpened 
(raised) pitch. 
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The pedals pose a unique technical challenge, not only for the harpist but also for 
the composer: it is crucial to understand that certain notes are simply not playable 
on the harp without changing the pedal positions, and care must be taken to 
ensure that the harpist is not being asked to make impractical pedal changes. 
Dorico offers a set of features to help write for the harp: support for harp pedal 
notation; a tool to calculate the pedal positions required to play a passage of 
music; and the ability to show notes in red if they cannot be played by the current 
pedal positions. Even composers who have a lot of experience in writing for the 
harp will find these tools helpful in proof-reading or assessing the practicality of 
their writing for this beautiful instrument. 

Creating harp pedal diagrams. You can either create a harp pedal diagram 
manually, by specifying the pedal positions or note names corresponding to the 
pedal positions, or using the tool to calculate the pedal positions based on the 
music. 

To create a harp pedal diagram manually, use the Shift+P popover for playing 
techniques. You can specify the pedal positions in one of two ways: 

§ Describing the pedal positions: use ^ for a pedal in its upper position (flat), - 
for a pedal in its central position (natural), and v for a pedal in its lower 
position (sharp). You can optionally include the pipe character | between the 
pedals on the left- and right-hand sides of the harp. You must specify 
positions for all seven pedals. For example, --^|^--^ would produce a harp 
pedal diagram suitable for E♭ major, with a flattened B, E and A. 

§ Specifying the pitches directly: write each note name using an upper case 
letter A–G, use b for flat and # for sharp. You can choose to specify all of the 
pitches, or only those which are sharpened or flattened, but note that if you 
omit a pitch, it will always be interpreted as a natural, rather than being 
unmodified from the previous harp pedal settings, if there are any. So you 
could type either CDEbFGAbBb or just EbAbBb to produce a harp pedal 
diagram equivalent to the previous example above. 

To create a harp pedal diagram automatically, select a note or other item on either 
staff of the harp at the position where you want the harp pedal diagram to be 
created, and choose Write ▶ Calculate Harp Pedals. Dorico will examine the 
music written from that point and calculate the necessary harp pedal settings, 
greedily trying to accommodate as much music as it can, assigning each pedal only 
once. Make sure View ▶ Note and Rest Colors ▶ Notes Out Of Range is switched 
on, as this will allow you to see the point at which the next change of harp pedal 
settings is needed, because one or more notes will appear in red. This calculation 
even takes into account trill intervals. 
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Appearance of harp pedal diagrams. By default, changes of harp pedal settings are 
not printed in full score or custom score layouts (instead being shown there using 
signposts), and appear as pedal diagrams in part layouts. To change these 
settings, go to the Harp Pedaling section of the Players page of Layout Options: 
activate Show harp pedaling to make harp pedal changes appear in the selected 
layout or layouts. 

Harp pedal changes appear either as text, with the right pedals written above the 
left pedals (below left), or as a diagram (below right): 

 

 
The new Harp Pedaling page of Engraving Options provides detailed options to 
control the appearance of both text and diagram appearance types. In particular, 
you can tweak the size, thickness, length and spacing of the components of the 
harp pedal diagrams, and specify their default vertical and horizontal position. 

For harp pedal changes written as text, you can among other things specify the 
order of the left pedals (some harpists prefer the order B C D rather than D C B), 
whether the text should be enclosed with a border, and so on. To change the font 
or size of the text, edit the Harp Pedal Settings paragraph style in Engrave ▶ 
Paragraph Styles. 

Partial pedal changes. When using the text-based appearance for harp pedal 
changes, you may choose to show only the pedals that are changed from the 
previous settings. Be aware that when you specify harp pedal changes yourself, 
any pedals for which you do not specify settings will be interpreted as being in their 
middle (natural) positions, rather than inheriting their position from the previous 
pedal change: however, Dorico can display partial changes, and indeed by default 
any pedal change that changes three or fewer of the seven pedals will appear as a 
partial change. 

To override this default setting, either deactivate Show partial pedal changes for 
changes up to n pedals, or change the value of n, on the Harp Pedaling page of 
Engraving Options. You can also override this on a per-change basis: activate the 
Partial pedaling property, and Dorico will show only those note names that have 
changed since the previous change of pedals, regardless of how many pedals have 
changed. Likewise, by deactivating Partial pedaling you can make a partial pedal 
change appear as a full one, with all pedals shown. 

By default, partial pedal changes written using note names are shown split over 
two lines, with right pedals over left pedals, but if you prefer to show them all in a 
single line, on the Harp Pedaling page of Engraving Options set Partial pedal 

E♭ F♮ G♮ A♭ 
D♮ C♮ B♭ 
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changes to Allow on a single line. This will show partial pedal changes on a 
single line up to the number of pedals specified in the adjacent option Show 
partial pedal changes in single line if fewer than n pedals. 

Default pedals. If you do not specify the pedal settings at the start of a flow, it will 
be assumed that all seven pedals are in their central (natural) positions, which 
means that any sharp or flat notes will appear in the red “out of range” color. As 
such, you are recommended to specify the harp pedal settings at the start of the 
flow, which is quickly done using Write ▶ Calculate Harp Pedals. 

Glissando playback. Dorico takes the harp’s prevailing pedal settings into account 
when calculating the notes to be played for a glissando line. It is recommended 
that you create appropriate harp pedal changes to ensure you hear the expected 
scale in a harp glissando. 

Viewing harp pedal signposts. By default, harp pedal changes will appear in 
layouts in which they should not be printed using signposts. If you do not want to 
see harp pedal changes, either hide all signposts by choosing View ▶ Signposts ▶ 
Hide Signposts, or toggle only Harp Pedals in the same submenu. 

Projects created in earlier versions. When you first open a project created in an 
earlier version of Dorico that already contains a harp instrument, you will not be 
able to create a harp pedal change until you save, close and reopen the project. 
This is because Dorico 3 sets up some additional information in the existing harp 
instrument upon opening and updating the project which cannot be read and used 
until the project is reopened. 

Playback templates 

Playback templates bind together information about the instrument sounds, 
articulations and playing techniques provided by a virtual instrument or other 
playback device, how to obtain those sounds (defined in a VST Expression Map), 
and which of those sounds to choose for each instrument in your project. In 
previous versions of Dorico, you were limited to one or two playback templates 
supplied with the program to use the supplied HALion Sonic SE and HALion 
Symphonic Orchestra sounds, or to use NotePerformer, and any use of other 
sound libraries or virtual instruments required manual setup that had to be repeated 
in every project. 

With the improvements in Dorico 3, it is now possible for you to set up your own 
playback templates, including custom combinations from different playback 
devices, and make everything reusable so it needs to be set up only once and can 
even be exported for use by other Dorico users. 



 

 
Dorico 3 Version History Page 41 Steinberg Media Technologies GmbH 

The playback templates supplied with earlier versions of Dorico can be thought of 
as automatic playback templates, in that Dorico can load the necessary sounds 
into the HALion Sonic SE and NotePerformer virtual instruments automatically. In 
Dorico 3, you can now create manual playback templates, in which you load a 
virtual instrument, load the sounds you want to use, and provide the mapping 
between the instruments in your project and those sounds by assigning VST 
Expression Maps in the Endpoint Setup dialog. You can save the setups for 
multiple VST instruments into a single manual playback template, which bundles 
together each endpoint configuration, all referenced VST Expression Maps, and all 
playback playing techniques and playing technique definitions referenced by the 
VST Expression Maps. 

Creating manual playback templates. To create a manual playback template: 

§ First add players holding the target instruments to your project in Setup mode. 
§ Switch to Play mode and load the VST instrument you want to configure into 

the VST Instruments panel, show its interface by clicking the Edit Interface 
button (its icon is a lower-case e), and load the sounds you want to use for the 
instruments in your project. 

§ Use the track header controls on the left-hand side of the event display in Play 
mode to assign each instrument to the appropriate channel of your VST 
instrument. 

§ In the VST Instruments panel, click the corresponding Endpoint Setup button 
(its icon is a cog) to open the Endpoint Setup dialog. If you are not familiar 
with the Endpoint Setup dialog, please refer to the Operation Manual here. 
For each entry in the table, check that the Port, Channel and Assigned 
Instruments columns are all correct, and assign an appropriate VST 
Expression Map using the menu in the Expression Map column. If no 
appropriate VST Expression Map yet exists, create one using Play ▶ 
Expression Maps (refer to the Operation Manual here). If the instrument is a 
percussion kit, assign an appropriate percussion map using the menu in the 
Percussion Map column, too. 

Once these steps are complete, you can either save a single manual playback 
template for this VST instrument by clicking the Save Manual Playback Template 
button in the Endpoint Setup dialog, or you can repeat the above steps for one or 
more additional VST instruments, then click the Save Manual Playback Template 
button in the action bar at the bottom of the VST Instruments panel, which saves a 
manual playback template that contains data for all of the instruments currently in 
the rack. 

Creating playback templates. Once you have created one or more manual playback 
templates, you can combine them, together with Dorico’s default automatic 
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playback templates, into your own playback templates. To do this, choose Play ▶ 
Playback Template. This dialog has been revamped as follows: 

 

At the top of the dialog is a search field to allow you to filter the table of playback 
templates. The table itself can be sorted by name, or by whether or not the 
playback template is a factory default, in which case it will show the factory icon in 
the second column. The action bar below the table contains the following options, 
from left to right: 

§ Add: creates a new empty playback template. 
§ Duplicate: creates a new playback template, based on the selected playback 

template. 
§ Edit: edits the selected playback template. 
§ Show Factory: determines whether the factory default playback templates 

should be shown in the table, switched on by default. 
§ Export: exports the selected playback template as a file that can be installed 

on another computer. 
§ Import: allows you to find an existing playback template and import it so that it 

is available on this computer. 
§ Delete: deletes the selected user-defined playback template. 

To create a playback template, click the + button in the action bar at the bottom of 
the dialog. The Edit Playback Template dialog opens: 
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Specify the Name for your new playback template at the top of the dialog; Dorico 
will populate the ID field automatically, though you can edit it yourself if you click 
the lock icon to enable editing of the Creator, Version and Description fields. 
These fields are not consumed by Dorico directly, but particularly if you anticipate 
sharing your playback template with other users, you may want to provide some 
details here, and consider incrementing the Version number when you revise an 
existing playback template. 

The Entries table lists the manual and automatic playback templates that are used 
by the overall playback template, and they are listed in descending order of 
preference: that is to say, when applying the playback template, Dorico will attempt 
to assign each instrument to the first entry in the list, then the next entry in the list, 
and so on. Place the playback templates with your favourite sounds, or your 
specific choices for particular instruments, at the top of the list, and include a 
fallback – for example, one of Dorico’s default automatic playback templates – at 
the end of the list so that you can be sure that any instrument you add to your 
project will end up assigned to a sound automatically. 

The buttons in the action bar for the Entries table are as follows: 

§ Clicking Add Manual pops up a menu listing all of the manual playback 
templates found on your computer, and choosing one from the menu adds it to 
the Entries table. 
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§ Similarly, the Add Auto button pops up a menu listing all of Dorico’s default 
automatic playback templates, and choosing one adds it to the Entries table. 

§ The move up/move down buttons move the selected playback template higher 
or lower in the Entries table, affecting its preference order. 

§ Delete removes the manual or automatic playback template from this playback 
template, but does not delete it altogether. 

The Family Override and Instrument Override tables allow you to create specific 
overrides for families of instruments, or individual instruments, for each manual or 
automatic playback template. For example, you might want to specify that although 
your manual playback template for Vienna Symphonic Library includes solo and 
ensemble string instruments, you want to use a solo violin from EastWest 
Hollywood Strings instead: in that case, you would select the manual playback 
template for Hollywood Strings in the Entries table, then click + in the action bar 
for the Instrument Override table, and from the instrument picker that appears, 
choose Violin. 

In general, unless you have multiple manual playback templates in the same 
playback template that each provide sounds for the same instruments, you will not 
normally need to set any family or instrument overrides: it will usually suffice to 
ensure the playback templates are listed in preference order in the Entries table. 

All playback templates you create are available in all projects you create or open on 
your computer. 

Using a playback template. To use one of your own playback templates, simply 
choose Play ▶ Playback Template, either select the playback template from the 
table and click Apply and Close, or simply double-click the playback template, 
which automatically closes the dialog. 

Importing a playback template. If you receive an exported Dorico playback 
template, with file extension .dorico_pt, you can install it simply by dragging and 
dropping it onto the Dorico project window. After installation it will be available in 
Play ▶ Playback Template for the current and any future projects. 

Independent voice playback 

Play mode now allows you to specify that each voice belonging to each instrument 
should now be routed to a separate endpoint, making it possible to handle complex 
requirements like needing a separate MIDI channel for each sound in a virtual 
organ, or playing back divisi passages with the appropriate smaller sectional 
sounds. 
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Independent voice playback is enabled using the slide switch at the top of the 
instrument track header in Play mode. When activated, Dorico will automatically 
assign the additional voices to separate channels: it will fill empty channels in a 
remaining instance of the appropriate virtual instrument or add a new instance as 
required. 

Once independent voice playback is enabled, the drop-down immediately to the 
right of the slide switch is enabled and allows you to choose which voice’s 
information should appear in the controls below; by default, All voices is chosen, 
which means that the controls for output device, port and channel are all disabled. 
The piano roll display displays notes from all voices when All voices is chosen, and 
it is still possible to edit note velocity for these notes, but the automation and 
playing techniques lanes are disabled. 

When one of the individual voices is chosen from the drop-down, all of these 
controls become enabled, allowing you to override the routing for an individual 
voice. 

By default, Dorico maps the settings for a given voice – for example, Down-stem 
voice 1 – to the appropriate voice in all flows of the project, so you don’t have to 
make or adjust the setting for every flow. However, under some circumstances you 
may need to route voices independently even between flows, in which case you 
can click Set for This Flow (  ), which allows you to set the routing 
independently for each flow. This might be useful in complex multi-movement 
works with extended divisi and solo passages, for example: in the first movement, 
Up-stem Voice 1 might correspond to the solo violin in a divisi passage, but in the 
second movement, it could be the default voice for the violin section. You also have 
the option of adding an extra voice that you use only for a single passage in a 
single flow, as provided it doesn’t have any equivalent in another flow, you can set 
its routing independently but keep all other voices routed consistently for all flows, 
by setting Set for All Flows (  ). 

Independent voice playback cannot be set for unpitched percussion kits. 

Velocity and pitch bend editing 

Play mode now includes two new editors to expand the tools available for tweaking 
MIDI: a new velocity editor, and the addition of pitch bend editing to the existing 
MIDI controller editor. 
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Velocity editor. The velocity editor is hidden or shown for an instrument by clicking 
the new button in its track header. The velocity editor opens below the piano roll, 
and shows a vertical bar for every note; for chords, the vertical bars are stacked on 
top of each other, and you can bring one particular bar to the fore by selecting its 
note in the piano roll editor. The precise velocity value for a single selected note is 
shown in the spin control in the velocity editor’s track header, allowing you to 
specify the velocity value numerically by typing it in and hitting Return. 

The following tools in the Play mode toolbox operate on the velocity editor: 

§ Object Selection (arrow): using this tool you can click and drag any note’s 
velocity bar to increase or decrease the velocity value, or click anywhere within 
the existing height of the velocity bar to decrease the value.  

§ Draw (pencil): using this tool you can draw a freehand curve or other shape 
across a range of velocity bars by clicking and dragging; when you release the 
mouse pointer, the appropriate velocity bars will be edited according to the 
drawn contour. 

§ Line: using this tool you can click and drag to describe a straight line between 
two points; when you release the mouse pointer, the intervening velocity bars 
will be edited according to the angle of the drawn line. 

To remove edits to note velocity, select the notes whose velocities you want to 
reset and choose Play ▶ Reset Playback Overrides. This will also reset any other 
playback offsets you have created for those notes. 

Pitch bend editor. The pitch bend editor is integrated into the existing MIDI 
controller editor. The MIDI controller editor opens below the piano roll editor (and 
below the velocity editor, if that is shown). Choose Pitch Bend from the menu of 
MIDI controllers, and the editor display to the right will update, showing a central 
horizontal line representing the unmodified pitch. Points above the central line raise 
the pitch, while points below the line lower the pitch. 

You can use the Object Selection tool to select and drag any existing pitch bend 
data points, use the Draw (pencil) tool to draw in new points freehand, or use the 
Line tool to draw in a straight line between two points. Regardless of the grid 
resolution used when you enter the data points, the resulting pitch bend is 
discretized at a resolution of 1/32 quarter notes (crotchets) to ensure that it is 
played back smoothly. Pitch bend is expressed on a scale of -100 to +100, 
describing a maximum of one whole step (two semitones) in either direction from 
the written note. (STEAM-3886, STEAM-8123, STEAM-9533) 

Soundiron Olympus Choir Micro 

Dorico Pro 3 and Dorico Elements 3 now includes the complete Olympus Choir 
Micro choral sound library from Soundiron. Olympus Choir Micro has been 
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available for the Kontakt platform for some time, but the team at Soundiron has 
now re-engineered the library for HALion Sonic SE to take advantage of all of its 
capabilities. 

About the library. Olympus Choir Micro draws on the recordings Soundiron 
captured for their full Olympus Symphonic Choir library, assembling 63 singers 
from the San Francisco Choral Society, Volti and the San Francisco Symphony 
Chorus, under the direction of Robert Geary. The singers were recorded in a large, 
acoustically-optimal A-frame chapel hidden away in the wooden canyons of 
Montclair, in the San Francisco Bay Area. More than 90 hours of recordings were 
made, combining traditional deep sampling methods with Soundiron’s own 
specialized techniques to deliver a capable and comprehensive symphonic choral 
library. Olympus Choir Micro is an introductory sample library focused on the main 
close microphone position. The provided patches include a pair of standard vowel 
sustains – “ah” and “oo” – including both soft piano and strong fortissimo 
dynamics, sung by the full ensemble over the whole SATB range. 

The Olympus Choir Micro sounds are used by default for vocal instruments in new 
projects created in Dorico Pro 3 and Dorico Elements 3, and can be applied to 
projects created in earlier versions of Dorico by applying the default playback 
template. 

Controls. If you open the HALion Sonic SE interface and choose the Edit page of 
its interface, you will see the controls for the Olympus Choir Micro patches: 

 

Layer 1 corresponds to the lower, male voices, while Layer 2 corresponds to the 
higher, female voices. The circular button to the left of each of the Layer titles 
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toggles that layer on and off; if the button is switched off, that layer will produce no 
sound. 

The drop-down directly below the Layer title allows you to choose between the 
“ah” and “oo” vowel sounds, and the sustain, marcato and staccato articulations. 

The six knobs below the drop-dpwn are as follows: 

§ Swell controls the dynamic volume of the layer. 
§ Pan adjusts the stereo panorama of the layer. 
§ Attack controls the initial note attack time of the layer. Low values are quick, 

but higher values can be used to sweep up in volume over a longer period of 
time. 

§ Offset controls the sample start offset of the layer. Turning the knob up 
causes the sample playback to start further into the sample. 

§ Release controls the release fade time of the layer. This controls the amount 
of time it takes for the sound to reach silence once a note is released. 

§ Rel. Vol. adjusts the volume of release samples only. 

At the bottom of each Layer panel is a Dynamics slider, which adjusts how 
dynamics from piano to forte are controlled between note velocity and MIDI CC. 
When the slider is all the way to the left, only velocity controls dynamic change, 
and when it is all the way to the right, dynamics are fully controlled by the Swell 
knob (mapped by default to MIDI controllers 72 and 73). 

The central column between the two Layer panels contains a Blend toggle button: 
when switched off, both layers will sound at the same time, on top of one another; 
when switched on, the Blend slider can be used to morph between the two layers.  

Below the Blend slider, the central column shows different controls depending on 
whether you click the Legato, Vibrato or Keys button. The Legato controls are: 

§ Legato 1 toggle button enables or disables the simulated legato for the men’s 
voices layer. 

§ Legato 2 toggle button enables or disables the simulated legato for the 
women’s voices layer. 

§ The Time knobs control the speed of the legato transition for each layer. 
Slower values mean a longer crossfade during the transition. 

§ The Bend knobs add and adjust a simulated pitch bend to the legato transition 
for each layer. 

The Vibrato controls are: 

§ Vibrato 1 toggle button enables or disables the simulated vibrato for the 
men’s voices layer. 
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§ Vibrato 2 toggle button enables or disables the simulated vibrato for the 
women’s voices layer. 

§ The Level knobs control the depth and speed of vibrato, or the pitch/volume 
modulation. At low values this creates a subtle, slow vibrato, while increasing 
the value makes it more pronounced and faster. 

The Keys controls allows you to specify the lower and upper bounds for the men’s 
and women’s voice layers, which can be extended a little in both directions to 
expand the playable range of the patches. 

More information. For more information on the full version of the Olympus 
Symphonic Choir, visit Soundiron at www.soundiron.com/olympus 

Comments 

Comments allow you to mark up the score, attaching a comment bubble to a 
particular position (or rhythmic range) on a given staff. The comment consists of 
some text, which can be edited by double-clicking the comment bubble or 
selecting it and typing Return, and seen in the new Comments panel in Write 
mode. It’s also possible to reply to an existing comment, making it possible to use 
comments to discuss changes to a project, which is useful in a multi-person 
workflow. 

Identifying the author. By default, Dorico uses the account name of the current 
user account to determine the author of the comment. On Mac, this uses the long 
account name, e.g. GHolst, while on Windows it will look up the full name 
associated with the account, e.g. Gustav Holst. The author’s full name appears 
associated with each comment in the Comments panel, while a two-letter pair of 
initials (if there are any capitals in the user name, it will use the first two; otherwise 
it will use the first two characters of the user name) appears inside the comment 
bubble in the music, if shown.  

If Dorico is unable to determine an appropriate account name by default, the first 
time you create a comment, it will prompt you to enter both your chosen full name 
and initials. These choices can be changed later on at any time on the General 
page of Preferences, though the name of the author saved in any existing 
comments will not be updated automatically. 

Adding a comment. To add a comment, select an item in the music at the position 
where you want the comment to appear (or make a multiple selection, since a 
comment can refer to a range of bars, although there’s no visual feedback of this in 
the score itself; it is, however, shown in the Comments panel), and choose Write ▶ 
Create Comment, use the default key command Alt+C, or click the + button in 
the action bar at the bottom of the Comments panel in Write mode. If the caret is 
shown, the comment will be added at the caret’s location, ignoring the selection. 

https://www.soundiron.com/olympus
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A simple dialog opens, allowing you to type the comment. Simply hit Return or 
Enter to confirm the comment and add it to the score. To make it as quick as 
possible to add a comment, Return and Enter will always confirm the dialog. To 
add a line break to a comment, type Shift+Return instead. 

A comment bubble appears in the score above the selected staff, showing the 
initials of the author inside it. The comment also appears in the Comments panel. 

Editing a comment. To edit an existing comment, simply select the comment in the 
score and hit Return or Enter. Alternatively, double-click the comment in the 
Comments panel in Write mode, or select the comment in the Comments panel 
and click the pencil icon in the action bar at the bottom of the panel. 

The same dialog used to create a comment appears, showing the comment's 
current text. Make any required changes and hit Return or Enter to confirm the 
dialog. The timestamp for the comment is updated, but the original author is 
retained. 

Replying to a comment. To reply to an existing comment, select it in the score and 
choose Write ▶ Reply to Comment or use the default key command Alt+R. 
Alternatively, click the reply button in the action bar at the bottom of the Comments 
panel in Write mode. 

A dialog opens, allowing you to type your reply. Simply hit Return or Enter to 
confirm the comment and add it to the score. 

The reply will appear as a separate comment bubble in the score, directly below 
the comment it is replying to. In the Comments panel in Write mode, replies are 
shown indented immediately below the comment they reply to; there is only a 
single level of indentation, so any subsequent replies are also indented to the same 
level. 

Deleting a comment. To delete a comment, simply select it in the score and hit 
Delete, or select it in the Comments panel and click the delete icon in the action 
bar at the bottom of the panel. 

Exporting comments. It is possible to export the comments from a project in tabular 
form: click the export button in the action bar at the bottom of the Comments panel 
to export an HTML file, which is saved alongside the project file, and which 
automatically opens in your default web browser. Comments for all flows in the 
project are included. 

Comments panel. The Comments panel in Write mode shows all of the comments 
in the current flow. Each comment is shown in order of its rhythmic position (i.e. 
from the start of the flow to the end of the flow). Replies to comments are shown 
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inline directly beneath the comment to which they reply, indented by a small 
amount. 

Each comment shows the full name of its author, the date on which it was created 
(or last edited), and the name of the instrument and bar (or bars) in which it is 
found. The complete text of the comment is shown as well. 

If the Comments panel is visible, selecting a comment bubble in the music will also 
select it in the panel. The converse is also true: selecting a comment in the panel 
will select it in the score, and move the score view to bring the comment into view. 

The action bar at the bottom of the panel allows you to add a new comment (the 
button is enabled if there is a selection in the score), edit an existing comment 
(enabled if a comment is selected in the list), reply to an existing comment (again, 
enabled if a comment is selected in the list), export the comments in tabular form 
(enabled if there is at least one comment in the current flow), or delete an existing 
comment (enabled if a comment is selected in the list). 

Viewing comments. Comments can be hidden or shown in the score by choosing 
View ▶ Comments. Comments are shown by default. 

Comments are not printed by default, but they can be included when printing by 
activating View menu options in the Annotations section of the right-hand 
options panel in Print mode. 

Harmonics 

Dorico now supports various conventions for the notation of harmonics on stringed 
and fretted instruments, including both natural and artificial harmonics, including 
calculating the correct pitch to be notated for the second through sixth harmonics. 
Harmonics are numbered according to the nodes (or divisions into equal parts) of 
the string: the second harmonic divides the string in half; the third divides the string 
in thirds; the fourth divides the string in quarters; and so on. (STEAM-9265) 

Natural harmonics are produced by touching an open string at one of its nodes and 
then bowing or plucking it; the second harmonic is an octave above the open string 
pitch, the third a further perfect fifth higher, the fourth a further perfect fourth 
higher, the fifth a further major third higher, and the sixth a further minor third 
higher. Artificial harmonics, meanwhile, are produced by touching a stopped string 
at one of the nodes of its stopped length. This requires the player to both fully stop 
the string and touch the string at the node, which is a more difficult technique for 
the performer to master than playing a natural harmonic. 

Adding a harmonic. To add a harmonic, write the open or stopped string pitch, 
then activate the new Type property in the new Harmonics group of the Properties 
panel, and choose Artificial or Natural as needed. By default, the second 
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harmonic (i.e. an octave above the written pitch) is assumed, and for an artificial 
harmonic is written with a white diamond notehead above the nominal pitch; for a 
natural harmonic, the harmonic circle symbol is shown above the nominal pitch, 
except on guitar, where instead the nominal pitch is drawn with a black diamond 
notehead. 

Changing the node. To change to the third through sixth harmonic, activate the 
Partial property, and choose the number of the node at which the string should be 
touched: 2 is the second harmonic, 6 is the sixth harmonic. If the harmonic is 
shown using an additional white diamond notehead, the pitch of the white diamond 
notehead will be updated. 

Changing the appearance of natural harmonics. For natural harmonics, there are 
three possible appearances, accessed by activating the Style property: 

§ Circle above: this shows the harmonic circle symbol on the notehead side of 
the nominal note (and can be forced to the other side by activating the 
Harmonic placement property). 

§ Diamond notehead: this changes the notehead of the nominal note to a 
diamond notehead; filled when the note is a quarter note (crotchet) or shorter, 
and white or unfilled when the note is a half note (minim) or longer. 

§ White diamond notehead: this changes the notehead of the nominal note to 
a white diamond notehead, unfilled regardless of the note’s duration. 

Changing the type of artificial harmonics. For artificial harmonics, four different 
types of harmonic are supported, accessed by activating the Style property: 

§ Normal: shows two noteheads, the stopped pitch and the touched pitch 
(calculated based on the Harmonic property, or assuming the second 
harmonic if it is not set); in tablature, the stopped fret is shown, and 
immediately to its right, in parentheses, the touched fret (or position between 
two frets) is shown. 

§ Pinch: specifically a guitar technique, a pinch harmonic (also sometimes called 
a false harmonic or a squeal) is produced by the player catching the string at a 
node near the pick-ups after it is picked, which cancels out the fundamental 
tone of the string, and lets one of the higher overtones dominate, producing a 
high-pitched squeal. On a notation staff, a pinch harmonic shows two 
noteheads, the stopped position and the sounding pitch; in tablature, only the 
stopped position is shown. 

§ Single notehead (sounding): on a notation staff, this shows only the 
sounding pitch, i.e. the resulting harmonic; in tablature, this shows the stopped 
fret, and immediately to its right, in parentheses, the sounding pitch. 
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§ Single notehead (stopped): on a notation staff, this shows only the stopped 
pitch; in tablature, this shows the stopped fret, and immediately to its right, in 
parentheses, the touched fret (or position between two frets) is shown. 

Accidentals on harmonics. If necessary, you can override whether or not the 
accidental on the white diamond notehead is shown, hidden, or shown in 
parentheses by activating the Accidental property in the Harmonics group (as 
opposed to the one in the Notes and Rests group, which applies to the main 
notehead, rather than the harmonic notehead). As you can for accidentals on 
normal notes, you can also override the column in which the accidental appears by 
setting the Accidental column property (a value of 0 means the right-most 
column, with increasing numbers corresponding to each successive column to the 
left), and the precise horizontal position of the accidental relative to its column by 
setting the Accidental X offset property. 

Harmonics playback. As of this release, there is no specific playback support for 
harmonics. 

Grouped playing techniques 

Playing techniques can now display their duration using a continuation line, and 
they can now be grouped, allowing the notation of the transition from one playing 
technique to another with automatic alignment of all of the playing techniques in 
the group. 

 

There are three ways to create grouped playing techniques: during step-time input; 
from a selection; or by grouping existing playing techniques. 

Step-time input. To create a group of playing techniques in step-time input, show 
the caret and type Shift+P to open the popover. Type the name of the playing 
technique you want at the start of the group, followed immediately by ->, a crude 
approximation of an arrow. This tells Dorico that you want to extend the playing 
technique as you input and will follow it with another playing technique at a later 
rhythmic position. To input the example shown above, you would enter sul tasto-> 
into the popover, then hit Return, and either advance the caret with Space or by 
inputting more notes; when you are at the position at which you want the next 
playing technique to appear, type Shift+P again and type ord. and hit Return. To 
keep the group going, instead type ord.-> and then continue to advance the caret. 
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To end the current playing technique without entering a new one, enter ? into the 
Shift+P popover. 

Creating from a selection. You can create groups containing a pair of playing 
techniques from a selection: select the first position at which you want the first 
playing technique to appear, and the position at which you want the second 
playing technique to appear. These positions should be on the same staff; if you 
make a selection spanning multiple staves, the grouped playing techniques will be 
created only on the top selected staff. Type Shift+P to show the popover and 
enter, say, sul pont->sul tasto and hit Return. 

Grouping existing playing techniques. If you already have playing techniques in 
your score that you want to group, select them and choose Edit ▶ Playing 
Techniques ▶ Group Playing Techniques. The duration of all of the selected 
playing techniques other than the final one will be adjusted such that they all abut. 
Provided all of the playing techniques in the group are set to show transition lines, 
each of the abutting playing techniques will be joined with a transition line. 

Removing a playing technique from a group. You can remove a single playing 
technique from a group by selecting it and choosing Edit ▶ Playing Techniques ▶ 
Remove Playing Technique from Group. This does not edit the duration of the 
playing technique, so if you no longer want the playing technique to show a 
duration line, you should select it and shorten its duration with Shift+Alt+left 
arrow. 

Duration and transition lines. Most of the default playing techniques accessible via 
the panel in Write mode or the Shift+P popover are set to show default lines: 
duration is typically indicated by a solid line with an inward-pointing hook (the hook 
points towards the staff), while transition is typically indicated by a solid line with a 
right-pointing solid arrowhead. For text-based playing techniques, the duration and 
transition lines proceed from half of the x-height of the font used; for glyph-based 
playing techniques, they proceed from the vertical center of the glyph. 

The choice of duration and transition line, and their vertical placement relative to 
the playing technique, can be edited on the new Continuation tab in Engrave ▶ 
Playing Techniques: 
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It is not currently possible for you to define your own duration or transition line 
styles, but this is planned for a future release. 

The default horizontal position of the start of the line is determined by options in the 
new Continuation section of the Playing Techniques page of Engraving Options. 

Overriding appearance. Flexible control over the appearance of the duration and 
transition lines, including separate control over the line body style (solid, dashed, 
double, wedge, etc.) and the end cap (arrowhead, hook, terminal line, etc.), is 
provided via new properties in the Playing Techniques section of the Properties 
panel, which appear only in Engrave mode. 

Changes made to the appearance of the lines can be removed by way of Edit ▶ 
Reset Appearance. 

Order of playing techniques. You can specify the order in which playing techniques 
are stacked outside the staff by activating the new Tucking index property in the 
Playing Techniques group in the Properties panel. Changes to the tucking index 
apply to the whole group, but it is also possible to set the tucking index for a single, 
ungrouped playing technique. 

Editing in Engrave mode. If you select the first playing technique in a group in 
Engrave mode, you will see a small red handle immediately to its left: this handle 
allows you to move the entire group vertically, maintaining any offsets of individual 
playing techniques in the group. Otherwise, you can select any playing technique 
and nudge or drag it, and if a line proceeds from its right, the start position of the 
line will move in step with the playing technique. Similarly, if you move a playing 
technique joined by a line to its left, moving the playing technique will move the end 
position of the line in step. You can also move each end of the line between two 
playing techniques freely, and those offsets will be maintained when the attached 
playing technique is moved. 

Offsets made in Engrave mode can all be removed by selecting the grouped 
playing techniques and choosing Edit ▶ Reset Position. 
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Repeated glyph playing techniques. If you created any playing techniques that use 
the repeated glyph appearance in a previous version of Dorico – for example, a row 
of harmonics as a single playing technique with duration – be aware that, due to 
the changes required to show transition and duration lines for other playing 
techniques, those repeated glyph playing techniques will end one note earlier in 
Dorico 3 than they did in previous versions. 
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Improvements 

Arpeggio signs 

Slur-style arpeggio signs. On page 242 of Gardner Read’s Music Notation he 
shows a picture of a slur rotated through 90 degrees such that it is vertical, 
enclosing the notes of a chord, as an alternative appearance for an arpeggio sign. 
Though Read argues that this is dubious notation, some composers use this 
notation in a distinct way from a normal wiggly arpeggio sign: the slur-like sign is 
an instruction to spread the chord only a little, while a wiggly arpeggio sign is 
interpreted as a more fulsome spread. Dorico now provides this slur-style arpeggio 
sign, which you can create by typing slurarp into the Shift+O popover, or by 
clicking the appropriate button in the Arpeggiation section of the Ornaments 
panel in Write mode. 

The new option Default curved arpeggio length on the Timing page of Playback 
Options allows you to determine the playback effect of the slur-style arpeggio sign. 
(STEAM-9352) 

Non-arpeggio signs. New options for the vertical placement of the ends of non-
arpeggio brackets have been added to the Endpoint Positioning section of the 
Arpeggio Signs page of Engraving Options. (STEAM-8568) 

Auto-save 

Auto-save location. The preference allowing you to determine where the AutoSave 
folder Dorico uses for auto-save has been removed, and the AutoSave folder is 
now located inside your user-level application data folder, to prevent calamities 
where users inadvertently set their main project folder to the same folder as used 
by auto-save, resulting in projects getting deleted unexpectedly when closing 
Dorico when unneeded auto-saves are cleaned up. (STEAM-9359) 

Bar numbers 

Bar number placement. The options for bar number placement on the Bar 
Numbers page of Layout Options have been expanded; in previous versions, bar 
numbers could appear in only one place relative to the system, namely either above 
the top staff of the system or below the bottom staff of the system. In Dorico 3 it is 
now possible to show bar numbers in multiple places on the system: above the top 
staff of the system; below the bottom staff of the system; and optionally above the 
top staff belonging to specific players. (STEAM-9142)  

Bar numbers and multi-bar rests. The following improvements have been made to 
the interaction of bar numbers and multi-bar rests: 

§ When bar numbers are set to be shown on every bar and the layout also shows 
multi-bar rests, Dorico will no longer hide a bar number on a multi-bar rest for a 
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single bar; the rest must contain at least two bars. When used in conjunction 
with the option to show ranges of bar numbers on multi-bar rests, this ensures a 
bar number appears between every pair of barlines. (STEAM-9399) 

§ If bar numbers are drawn centered on the barline, and the option to show 
ranges of bar numbers on multi-bar rests is set, the bar number at the start of a 
multi-bar rest will be hidden, to avoid redundantly showing the same bar number 
twice. (STEAM-9398) 

Bar number enclosures. If a bar number is drawn inside a circular or rectangular 
enclosure, the enclosure now erases items in the background of the music, which 
improves the appearance of bar numbers if they are drawn on top of barlines. 
(STEAM-9127) 

Chord symbols 

Chord symbols in slash regions. In previous versions of Dorico, showing chord 
symbols for only a short passage is hard work, because you have to show them for 
the whole instrument, and then hide them everywhere you don’t want them to 
appear. It’s common for chord symbols to appear on melodic instruments only 
when they’re expected to play a solo, in which case that will often be denoted by a 
region of slashes. 

To accommodate this common scenario, a new option has been added to the 
Chord Symbols submenu in the Players panel in Setup mode: Show in Chord 
Symbol and Slash Regions, alongside the existing options to show them for all 
instruments held by the player, none of the instruments held by the player, or only 
for the rhythm section instruments held by the player. 

When Show in Chord Symbol and Slash Regions is chosen, chord symbols 
appear for an instrument only in the ranges of bars and beats covered by a slash 
region. (STEAM-9400) 

Chord symbol regions. Should you need to show chord symbols for a range of 
bars and beats in an instrument but you don’t, for whatever reason, want to notate 
slashes in that region, you can instead create a new chord symbol region. 

This can be created by selecting one or more items in the score and choosing 
Write ▶ Create Chord Symbol Region. The chord symbol region is shown as a 
solid line drawn against the top line of the staff, which can be selected and, when 
selected, shows handles in Write mode (it shows no handles in Engrave mode). 
Those handles can be dragged around with the mouse to change the extent of the 
region, and the usual Alt+left/right (to move the whole region) and 
Shift+Alt+left/right (to move the end of the region) shortcuts work as expected. 
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The staff itself also shows a highlight in the chord symbol region, which can be 
switched on or off via View ▶ Highlight Chord Symbol Regions. 

When you create a chord symbol region on an instrument for the first time, if chord 
symbols are not already set to appear on that instrument, Show in Chord Symbol 
and Slash Regions (in the Chord Symbols submenu of the player’s context menu 
in the Players panel in Setup mode) will be automatically set for that instrument, so 
that any chord symbols in the region will automatically appear as soon as the 
region is created. (STEAM-9445) 

Clefs 

Showing clefs according to layout transposition. You can choose what type of clef 
should be used for a given clef depending on the layout transposition, e.g. to show 
a treble clef in the transposed pitch part but show a bass clef in the concert pitch 
score. However, for some instruments – particularly those that comfortably cover 
the bass and treble clef ranges, such as tenor saxophone – it may be necessary to 
have a clef change that does not appear in one or other kind of transposition. 

To accommodate this, a new Show for transposition property has been added to 
the Clefs group of the Properties panel. When the property is unset, the clef 
change will appear both in layouts set to concert pitch and in layouts set to 
transposed pitch. If the property is set, however, the clef will appear only in layouts 
using the chosen transposition type: in layouts that use the other transposition 
type, the clef will appear only as a signpost, and will not affect the staff position of 
notes. (STEAM-9449) 

Explicit clefs at the start of the flow. An explicit clef at the start of the flow, which 
may be needed to change the default clef chosen by Dorico for a particular 
instrument, no longer prevents that staff from being hidden if it is otherwise empty. 
(STEAM-9466) 

Dynamics 

Position of poco/molto modifiers for hairpins. A new option Position of modifier 
text on hairpin has been added to the Gradual Dynamics section of the 
Dynamics page of Engraving Options, allowing you to choose between showing 
modifiers like poco and molto below or above the start of the hairpin, or centered 
on the hairpin, like this: 

 

This appearance can also be chosen by way of the new Modifier position property 
in the Dynamics group in the Properties panel. In Engrave mode, a pair of Modifier 
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offset properties also appear, allowing you to adjust the position of the modifier 
relative to the hairpin. To aid legibility, the background around the modifier is 
always erased when it is centered on the hairpin, even if the Erase background 
property is not activated. (STEAM-9622) 

Increasing and decreasing dynamic intensity. Two new key commands have been 
added to the Note Editing category on the Key Commands page of Preferences: 
Decrease Dynamic Intensity and Increase Dynamic Intensity. As their names 
suggest, these commands allow you to decrease the intensity of an immediate 
dynamic (e.g. to decrease  to ), or conversely to increase it (e.g. to increase 
 to ). These commands have no effect on gradual dynamics, such as 
hairpins. (STEAM-9365) 

Fingering 

Removing fingering. A new command Edit ▶ Fingering ▶ Reset Fingering has 
been added, which removes all fingerings from the selected notes. (STEAM-9335) 

Fingering for cross-staff chords. A new Position for fingerings on cross-staff 
chords option has been added to the Position section of the Fingering page of 
Engraving Options, allowing you to specify whether fingerings should be split 
between both staves, all positioned above the top staff, below the bottom staff, or 
on the notehead or stem sides. This provides considerably more flexibility for 
positioning fingerings on cross-staff chords than before. 

A new property On home staff appears for selected notes with fingerings when 
Position for fingerings on cross-staff chords is set to any option other than 
Ignore cross-staff chords, which allows you to override the placement of an 
individual fingering such that it appears on the staff from which its note was 
originally crossed. (STEAM-9171) 

Fingering within the staff. It is now possible to position fingerings for keyboard and 
other instruments inside the staff instead of above or below: select the note to 
which the fingering you want to move inside the staff belongs and enable the new 
Inside staff property in the Fingering group of the Properties panel. Fingering 
substitutions cannot be made to appear within the staff using this property. 

The fingering will be positioned according to the options in the Position section of 
the Fingering page of Engraving Options, and can be nudged or dragged in 
Engrave mode. (STEAM-9170) 

Glissando lines 

Glissando playback. Glissando lines now play back using discrete notes; 
continuous sliding glissando playback is not yet supported, but is planned for a 
future version. When written for harp, glissando playback takes into account the 
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current harp pedal settings (or an assumed default of all pedals in their natural or 
central position if no explicit harp pedal settings are provided), while for other 
instruments, glissando playback uses the chromatic scale. 

If the notes at either end of the glissando are written with ties, Dorico will take this 
into account: if the starting note of the glissando is tied, the glissando will start 
from the rhythmic position of the last notehead in the tie chain; if the ending note of 
the glissando is tied, the glissando will end at the rhythmic position of the first 
notehead of the tie chain. 

To override the point at which the glissando begins to play back, activate the new 
Delayed start property, which will cause the glissando to start playing back 
halfway between the starting and ending note. You can additionally activate the 
Delay property and specify the exact starting point of the glissando using fractions 
of a quarter note. (STEAM-3908, STEAM-9312) 

Lyrics 

Adjusting the vertical position of a line of lyrics. It is now possible to adjust the 
vertical position of a whole line of lyrics independently on each system in Engrave 
mode. Select any lyric in the line and type Alt+up/down to nudge all of the lyrics in 
that line up or down; add Ctrl (Windows) or Command (Mac) to nudge the lyrics 
by a whole space at a time. 

Only the lines of lyrics you select will move when you nudge a line of lyrics: if you 
want to adjust the position of all lyric lines in the system by a consistent amount, 
select at least one lyric in each line you want to adjust before you nudge them. 

If the formatting of the music changes such that the rhythmic position of the music 
at the start of the system changes, any offsets for the lyrics on that system will be 
automatically removed. 

To remove the vertical adjustment on a particular system, select any lyric in any line 
on that system and choose Engrave ▶ Lyric Offsets ▶ Remove Selected 
Systems. You can remove all vertical adjustments in a particular music frame by 
selecting any lyric in that frame and choosing Engrave ▶ Lyric Offsets ▶ Remove 
Selected Frames. To remove all vertical adjustments for lyrics in the entire layout, 
choose Engrave ▶ Lyric Offsets ▶ Remove Layout. (STEAM-8926) 

Copying and pasting lyrics. It is now possible to paste lyrics word by word or 
syllable by syllable so you can, for example, input the lyrics for one vocal part, copy 
them to the clipboard after selecting them (using Edit ▶ Filter ▶ Lyrics is a 
convenient way to make this selection), then select the note in another vocal part 
where the lyrics should begin, type Shift+L to open the lyrics popover, and then 
use Ctrl+V (Windows) or Command-V (Mac) to paste. Dorico will paste each 
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word or syllable in turn, so all you have to do is press Space or – (hyphen) to 
create any necessary melismas. As you paste, the contents of the clipboard are 
consumed until all words and syllables have been pasted. 

This feature is not operable for lyrics written in Chinese, Japanese or Korean. 
(STEAM-9224, STEAM-9230) 

Edit Lyrics dialog. Proof-reading lyrics can be challenging, because lyrics are 
always more widely spaced than regular text, and often oddly split up over 
impractically large horizontal distances. 

To make it easier to find and fix typos and other mistakes in lyrics, a new 
command Edit ▶ Lyrics ▶ Edit Line of Lyrics has been added. It’s only enabled 
when there is a selection, and it will be inoperable unless the selection includes at 
least one lyric: if more than one lyric is selected, it’ll take the earliest lyric on the 
uppermost staff as the target to work out which lyrics it’ll show in the dialog. 
Assuming it finds a target lyric, the new Edit Lyrics dialog opens. 

The dialog shows the lyrics in that line in the current flow in a text editor, with 
hyphens and spaces as appropriate. At the bottom of the dialog is a read-out 
showing the number of lyrics in the text editor, and the target number of lyrics, i.e. 
the number of lyrics that exist already in that line in the flow. You can’t add or 
remove lyrics here, nor can you change their duration (though you can change their 
type from e.g. being the start of a word to being a whole word on their own). The 
action bar in the dialog allows you to increase/decrease the size of the lyric text, 
which makes it easier to read and edit it. 

The OK button will only be enabled and the dialog can only be confirmed by either 
clicking OK or hitting Return if the number of lyrics in the editor matches the target 
number. The read-out is updated as you type, so you can see when the target is 
reached. 

When you confirm the dialog, Dorico rewrites the entire line of lyrics. In common 
with editing a lyric via the Shift+L popover, properties (like Italic etc.) will be 
removed when you confirm the dialog, because behind the scenes the lyrics are 
actually deleted and recreated. (STEAM-9231) 

Multi-bar rests 

Bar count appearance. It is now possible to change the appearance of the bar 
count digits that appear above or below the H-bar or old style rests in a multi-bar 
rest. A new option has been added to the Rests page of Engraving Options, Bar 
count appearance, allowing you to choose between Music font (which uses 
the Multi-bar Rest Bar Count Font font style) and Plain font (which uses 
the Multi-bar Rest Bar Count Plain Font font style). (STEAM-9141) 
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Position of bar count. A new option Placement for bar count on single-staff 
instruments has been added to the Rests page of Engraving Options, allowing 
you to specify that the bar count number should be shown above or below the 
staff. (STEAM-9590) 

Breaking multi-bar rests. If an immediate dynamic follows a gradual dynamic and 
coincides with the start of a multi-bar rest, the dynamic – which will be drawn at 
the end of the bar of music before the first bar of the multi-bar rest – no longer 
causes the multi-bar rest to be split unexpectedly. Similarly, a divisi change at the 
start of an otherwise empty bar will no longer prevent that bar from being 
consolidated into a multi-bar rest. Beware that these changes can cause the 
casting-off of existing projects to change. (STEAM-9195, STEAM-9314) 

Navigation 

Navigation in Write mode. In previous versions of Dorico, navigation in both Write 
and Engrave modes was based on the graphical proximity of items in the direction 
of navigation. This approach works well in Engrave mode, where navigation is 
typically over shorter distances and there are a greater number of selection targets: 
for example, in Engrave mode a single note may have separate selection targets for 
its notehead, stem tip, accidental, rhythm dot, and so on, whereas in Write mode, 
that same notehead has a single, much larger selection target. The result of this 
approach was that in Write mode, it was hard to predict what item would be 
selected, and then moving back in the opposite direction would often not select the 
last item that had previously been selected. In order to make navigation with the 
arrow keys in Write mode quicker and more predictable, this aspect of the software 
has been revamped in Dorico 3. 

The general principle is that in Write mode you will typically want to navigate using 
notes, rather than other items. As such, with a note selected: 

§ Typing ← or → will select the previous or next note in the same voice. 
§ Typing ↑ or ↓ will select the nearest note above or below the selected note on 

the same staff, if there is one; otherwise it will navigate to the staff above or 
below. When navigating to the staff above, it will select the lowest note starting 
or sounding at that position, and when navigating to the staff below, it will select 
the highest note; or a rest if no note is found. 

§ Typing Ctrl+← (Windows) or Command-← (Mac) or Ctrl+→ (Windows) or 
Command-→ (Mac) will navigate to the start of the previous or next bar on the 
current staff. 

§ Typing Ctrl+↑ (Windows) or Command-↑ (Mac) or Ctrl+↓ (Windows) or 
Command-↓ (Mac) will navigate to the top staff or bottom staff in the current 
system. 
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To select other kinds of items, type Tab to cycle forwards or Shift+Tab to cycle 
backwards through the other staff-attached items at the current rhythmic position 
on the selected staff. Whichever direction you cycle in, eventually the selection will 
return to the note or rest on the staff at that position. With a non-note or rest item 
selected, you can type ← or → to select the previous or next item of the same type 
on the same staff; this can be useful for navigating longer distances. You cannot 
cycle the selection onto a system-attached item (for example, a tempo, rehearsal 
mark, chord symbol, etc.) using Tab or Shift+Tab, but having selected a system-
attached item, you can still type ← or → to select the previous or next item of the 
same type. 

In previous versions of Dorico, Tab and Shift+Tab navigated to the next or 
previous barline. If you want to restore this behaviour, you can do so on the Key 
Commands page of Preferences. In the Selection and Navigation category, you 
can bind Navigate to the Next Barline to Tab and Navigate to the Previous 
Barline to Shift+Tab. The two new commands to cycle forwards and backwards 
through the other staff-attached items are Navigate to Next Item at Position and 
Navigate to Previous Item at Position, so you could instead assign these to 
alternative key commands. 

Note input 

Note input onto multiple staves. You can now extend the caret across multiple 
staves in order to input onto multiple staves at the same time. When the caret is 
visible, type Shift+↑ to extend it to the staff above or Shift+↓ to extend it to the 
staff below. 

This is especially useful when inputting via a MIDI keyboard, since it allows you to, 
for example, extend the caret across four horn staves and play a four-note chord on 
your keyboard; Dorico will automatically assign each of the four notes to the four 
staves within the span of the caret. 

If you would prefer Dorico to input all of the notes you play onto each of the staves 
instead of distributing them between all of the staves, on the MIDI Input page of 
Note Input Options, set Chord played when caret spans multiple staves to 
Input all notes on each staff. 

You can also input slurs, dynamics and other markings on all of the staves within 
the span of the caret in the usual way using their respective popovers. 

When the caret spans the two staves of a piano, Dorico follows the value of Split 
at MIDI note number on the Play page of Preferences when determining how the 
music should be distributed. (STEAM-9640) 
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Extending notes. Two new commands have been added to the Write ▶ Edit 
Duration submenu: Extend to Next Note and Extend to End of Selection. 

§ Extend to Next Note works its way through every selected rhythmic note (not 
grace notes) and finds the position of the next note in the voice, if there is one, 
effectively filling up any gaps between notes in the voice. 

§ Extend to End of Selection only operates on the selected note at the latest 
rhythmic position. It extends that note to the end of the selection using chord 
mode, so any intervening notes in the same voice will be merged together with 
the extended note. (STEAM-9273) 

Lock Duration and grace notes. Engaging Lock Duration (default key command L) 
when the caret is at the position of a grace note now leaves the caret at the same 
position, rather than advancing it to the next rhythmic note. (STEAM-9343) 

MIDI devices. Dorico can now detect when you connect or disconnect a MIDI 
input device while it is running, so you no longer need to restart Dorico after 
connecting a MIDI keyboard in order to use it for input. (STEAM-9575) 

MIDI monitoring. When playing notes on your MIDI keyboard outside of note input, 
Dorico now changes the instrument sound used for auditioning based on the most 
recent staff on which you made a selection, so to change the sound used for 
auditioning, simply select something on the staff that uses the desired sound. 
(STEAM-9469) 

MIDI thru. If you have a keyboard that makes sound, or if you have your keyboard 
hooked up to another sound source (e.g. an instance of Ivory in stand-alone mode), 
you might not want to hear any sounds echoed back when playing on your MIDI 
keyboard. A new option, Enable MIDI thru, has been added to the Play page of 
Preferences, switched on by default. When switched off, notes played on your 
MIDI keyboard will not be echoed by Dorico. (STEAM-9456) 

MIDI activity indicator. There is a new MIDI activity indicator in the bottom right-
hand corner of the project window. When Dorico receives MIDI data, it lights up 
green for a moment. If you see it lit up green constantly, that suggests that one or 
more of the hardware or software MIDI devices connected to your computer is 
flooding Dorico with data, and you should work out which device is causing the 
problem and eliminate it from your system. (STEAM-9632) 

Ossias 

Barline joins. A new option Join ossia with systemic barline for systems with 
only one instrument has been added to the Ossias section of the Barlines page 
of Engraving Options. By default this is switched off in new projects, but it is 
switched on in projects created in earlier versions. It is considered more correct for 
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a system consisting of a single main staff for a single instrument to not be joined to 
its ossia by a systemic barline at the left margin, and this option now provides that 
appearance. (STEAM-9580) 

Page layout 

Vertical justification. The calculations Dorico uses to vertically justify staves and 
systems to fill the height of a music frame have been revamped. In particular, when 
a frame’s fullness is calculated to be between the threshold for justifying only the 
staves and justifying both staves and systems, the previous calculation would 
overcompensate for items protruding above or below the staff, even if there was 
sufficient space to spread the deviation between the other gaps. This is now 
handled much more elegantly. 

Be warned that this may result in the vertical justification result being different than 
previous versions of Dorico for layouts with multiple systems per-frame, but you 
should find that you can use Engrave ▶ Staff Spacing ▶ Reset Layout to remove 
any spacing adjustments that you created to even out the result in a previous 
version and the new default result will be much more pleasing. (STEAM-9370) 

Frame fullness indicator. When the staff spacing tool is active in Engrave mode, a 
new read-out at the bottom of each music frame shows how full it is, expressed as 
a percentage. (STEAM-9064) 

Playback 

Playback from a selection. When starting playback by selecting a note or other 
item and typing P, Dorico is now more lenient about the precise nature of the 
selection, and will play back all instruments even if more than one item at the same 
rhythmic position on a single instrument is selected. This means that if you 
accidentally select, say, a note and a slur at the same time and type P, Dorico will 
still play back the whole ensemble rather than just that staff. (STEAM-9133) 

Metronome click. It is now possible to enable or disable the metronome click 
during playback, either by clicking the Click button in the mini-transport or by 
typing a custom key command assigned to the new Enable Click command in the 
Play category on the Key Commands page of Preferences. (STEAM-9457) 

Swing 16ths. Dorico now supports the “swing 16ths” rhythmic feel, in which 
sixteenth notes (semiquavers) are swung, rather than eighths (quavers). 

To choose one of the provided swing 16ths rhythmic feels as the default rhythmic 
feel for your project, choose your preferred feel from the Default rhythmic feel 
drop-down on the Timing page of Playback Options. 

To use one of the swing 16ths rhythmic feels for a particular passage, open the 
Shift+T popover and type e.g. Medium swing 16ths to choose that rhythmic feel; 
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the various presets will appear in the list of suggestions while you are typing into 
the popover. 

You can also edit the provided rhythmic feels or define new ones in the Edit 
Rhythmic Feels dialog, which is accessed by clicking Edit in the Rhythmic Feel 
section of the Timing page of Playback Options. (STEAM-9167) 

Beat stress. The Beat stress options on the Dynamics page of Playback Options 
have been improved to better take account of compound meter and irregular beat 
groupings, and for the first time Dorico will now differentiate between the first and 
subsequent beats of a bar or other beat grouping, according to the two options 
provided. (STEAM-5437) 

Playback of percussion kits. Dynamics entered on the five-line or grid presentation 
type are now respected in playback. Dorico builds up the dynamics to be played 
first by examining the dynamics written on the individual percussion instruments 
that comprise the kit, and merges in any dynamics that appear only in the five-line 
or grid presentation types. This means that it is now much simpler to add dynamics 
to drum sets and orchestral percussion kits. (STEAM-7093) 

Manually assigning endpoints. When using an automatic playback template (one 
where Dorico can automatically load sounds, which in practice means one that 
uses HALion Sonic SE or NotePerformer), if you manually adjust the endpoint 
assignment of any instrument in Play mode, Dorico will now continue to 
automatically load sounds for any new instruments that are added to the project; in 
previous versions, changing any assignment would disable any further automatic 
sound loading altogether. In addition, choosing Play ▶ Load Sounds for 
Unassigned Instruments will now do exactly what it says: if any instruments do 
not have a valid endpoint assignment, Dorico will set new assignments and load 
the appropriate sounds. (STEAM-9356) 

Renaming VST instruments. A new Name field has been added to the Endpoint 
Setup dialog, accessed by clicking the cog icon for a specific plug-in in the VST 
Instruments panel in Play mode. The chosen name will then appear both in the VST 
Instruments panel and in the Mixer. (STEAM-9148) 

Numbering VST instruments. Each plug-in in the VST Instruments panel in Play 
mode is now numbered, and the same number appears in the title bar of the plug-
in’s window, when it is shown. The first instrument plug-in will normally be 
numbered 02, because the DoricoBeep plug-in used for the metronome click will 
normally be numbered 01. The number is not significant, other than to 
disambiguate each plug-in from the next and to help you to identify them, and it is 
not possible to reorder plug-ins in the panel. (STEAM-9415) 
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Missing VST instruments. If a project references a VST instrument that is not 
available, an entry for the missing plug-in will appear in the VST Instruments panel 
in Play mode, its name surrounded by exclamation marks: for example, !! Kontakt !!. 
(STEAM-6032) 

Applying a playback template. When one of the automatic playback templates is 
applied (e.g. the built-in HSSE+HSO (Pro) playback template), the sounds loaded 
for each instrument into each instance of HALion Sonic SE will be loaded in score 
order, instead of in the order in which the instruments were originally created. 
(STEAM-9303) 

Duplicate percussion map. A new Duplicate button has been added to the action 
bar in Play ▶ Percussion Maps, allowing you to duplicate an existing percussion 
map as the basis of a new one. (STEAM-9452) 

Print mode 

Navigating the print preview. You can now type Home or End to go directly to the 
first or last page in the print preview; if you would prefer to use a different key 
command, you can define your own shortcuts for the commands Print Preview 
First Page and Print Preview Last Page in the Print category on the Key 
Commands page of Preferences. (STEAM-9166) 

Project Info 

The Project Info dialog has been significantly reworked both to make it modeless 
(i.e. you can leave it open while you work, and click Apply to apply any pending 
changes, leaving the dialog open), to replicate as far as is possible the functionality 
of the Flows panel in Setup mode, and to make it possible to change the info for 
multiple selected flows at the same time. 

Flows list. The flows list on the left of the Project Info dialog allows you to make a 
multiple selection of flows and the project itself. You can use Shift+click and 
Ctrl+click (Windows) or Command-click (Mac) to make your selection. 
Depending on what is selected in the list, the buttons in the action bar will 
enable/disable as appropriate: 

§ Add Flow is always enabled. 
§ Duplicate Flow is enabled only when a single flow (and not Project) is 

selected. 
§ Rename Flow is enabled only when a single flow (and not Project) is 

selected. 
§ Move Up/Move Down are enabled when one or more flows is selected, 

but not when Project is selected; Move Up is disabled when the first flow 
in the list is selected (because you can’t move the first flow up above 
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Project), and Move Down is disabled when the last flow in the list is 
selected. 

§ Delete Flow is enabled when at least one flow (and not Project) is 
selected. 

Clicking Add Flow adds a new flow to the end of the flows list. You can set info for 
that flow, and the flow itself will be created only when you click Apply. 

Clicking Duplicate Flow will add a new flow after the selected flow in the flows list.  

Clicking Rename Flow will bring up a simple modal dialog in which you can 
provide the new name of the flow. The flow will only be renamed when you click 
Apply in the parent dialog. 

When you click Move Up or Move Down, if the selection of flows is discontiguous, 
the flows will be gathered together and then moved as a block up and down 
through the list of flows. Again, the actual operation to reorder the flows in the 
Flows panel and in the project will only be carried out when you click Apply. 

When you click Delete Flow, the flow is removed from the list right away, but the 
edit will only be carried out when you click Apply. 

Changing info for multiple flows. You can make a multiple selection in the flows list 
on the left-hand side of the dialog. The fields on the right-hand side will update to 
show any values in common between the flows (and the project info itself, if 
Project is selected). Common values, i.e. that are the same in all selected flows/the 
project, appear in the appropriate line edit, and this includes where the common 
value is that no value is set, i.e. the line edit will be empty. Values that differ 
between the selected flows/the project will instead show the placeholder text 
Mixed in the line edit. You can overtype this placeholder text to set the value for all 
selected flows/the project. 

You can also copy the values from one flow or the project to all selected flows 
using the Copy info from drop-down on the right-hand side of the dialog. This list 
will only show flows (or the project itself) that are not selected in the flows list on 
the left, so if you select all rows, the drop-down and the Copy button will be 
disabled. If you choose a flow or the project from the drop-down and click Copy, 
all values from the chosen flow/project will be applied to all of the selected flows. 

Applying the changes. When you click Apply (or Close and choose to apply the 
changes in the message box that appears), Dorico applies all of the pending 
changes. Some of these edits – in particular, adding, duplicating, deleting or 
reordering flows – can take a while to complete in larger scores. No progress 
dialog appears, but the busy pointer will appear while the operation is performed. 
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New default key command. File ▶ Project Info now has the default key command 
Ctrl+I (Windows) or Command-I (Mac). (STEAM-9476) 

Staff labels 

Numbering for transposing instruments. A new option Numbering for similar 
instruments with different transpositions has been added to the Staff Labels 
page of Engraving Options. The default value is Number separately, which is what 
Dorico has always done: Horn in F 1.2 will be numbered separately from Horn in D 
1.2. The other value is Number together, which means that for two Horns in F and 
two Horns in D, you would get Horn in F 1.2 and Horn in D 3.4. (STEAM-9151) 

Tempo 

Tempo equations. The horizontal placement of tempo equations relative to the 
different kinds of special barlines has been improved. (STEAM-9095) 

Muting tempos. If you activate the Suppress playback property (called Muted in 
previous versions of Dorico) for a selected tempo, that tempo will no longer have 
any effect in playback. (STEAM-5161) 

Text 

Tokens context menu. When you right-click in the text editor in a text frame, a 
context menu appears listing all of the non-indexed tokens (i.e. those that don’t 
require the use of the flow number, e.g. {@flow3title@}), in categorized submenus. 
If you choose a token from the menu, it is inserted at the current cursor position in 
the editor. 

Submenus are provided for Project Info, Flow Info, Current Date, Project Save 
Date, Pages (i.e. page counts/page numbers), Music Symbols, and a handful of 
miscellaneous tokens are added to the bottom of the menu. 

The tokens for time and date, in the Current Date and Project Save Date 
submenus, show you how each token will be resolved rather than merely a 
description. Note that the Project Save Date menu also shows the current 
date/time rather than the date/time that will be shown in the frame itself. (STEAM-
9272) 

Music symbol tokens. You can now add flat, natural and sharp symbols to text in 
text frames using the new tokens {@flat@}, {@natural@} and {@sharp@}. When 
resolved, these tokens will change to the Music text character style (which uses 
Bravura Text by default) and insert the appropriate accidental symbol. You can 
insert any SMuFL symbol by specifying the code point as a token: for example, 
{@U+E050@} will insert a treble clef. You can find the necessary code points in 
the SMuFL specification here: https://w3c.github.io/smufl/gitbook/ 

https://w3c.github.io/smufl/gitbook/
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You can also include these music symbol tokens in Project Info fields. For 
example, you can now write Symphony in B{@flat@} major into the Title field, 
and you’ll get the expected result of “Symphony in B♭ major”. (STEAM-9238) 

Staff label tokens. New tokens {@staffLabelsFull@} and {@staffLabelsShort@} 
have been added, allowing you to insert the staff labels of the player or players in 
the current layout in a text frame. The value resolved by these tokens may not 
match exactly the staff labels as they appear to the left of the staff, but they do take 
into account the basic options for how transposition should appear, as found on 
the Staves and Systems page of Layout Options. These new tokens may be 
usefully used in place of {@layoutName@} for the name of the instrument at the 
top left-hand corner of the first page of a part layout. (STEAM-9274) 

Standard text editing shortcuts. You can now toggle bold, italic and underline 
styles for fonts that support these styles when editing text using Ctrl+B, Ctrl+I and 
Ctrl+U (Windows) or Command-B, Command-I and Command-U (Mac). 
(STEAM-9271) 

Missing Fonts dialog. You have a lot of control over which fonts are used in your 
Dorico projects, but when you send a project to another user or open it on another 
computer, you have until now had no way of knowing whether or not the fonts used 
in the project are present on that computer. 

This may be particularly problematic when moving from Windows to macOS and 
back again: on Windows, fonts can only use four standard styles (regular, italic, 
bold, bold italic) and so fonts with extended weights end up effectively as separate 
families, e.g. “Minion Pro Condensed Regular” would be a separate family on 
Windows, whereas on macOS the “Minion Pro” family would list “Condensed” as 
one of its weights/styles. 

To bring these issues to light, a new option Warn when projects use fonts not 
installed on this computer has been added to the Files section of the 
General page of Preferences, switched on by default. 

When this option is switched on, during file loading Dorico checks all of the font 
styles, paragraph styles, character styles and text events in the project to see 
whether they refer to font families and styles that are not present on the computer.  

If Dorico determines that one or more font or text styles used by items or text 
events in the project use a font that is not found on the system, it then shows a 
dialog in which it lists each font family and style, together with the type of 
entity/item by which it is referred. You can simply click OK to continue opening the 
project, in which case no changes will be made and the project will show the same 
warning next time it’s opened.  
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To specify a replacement font, click under Replacement Family to open a font 
menu. Type the first few letters of the name of the font family you are choosing to 
narrow your search. Having chosen the desired font family, you can then choose 
the style (if you don’t choose a style, it will assume you want the Regular weight). 

Having chosen one or more replacement font families, when you click OK the 
project will be loaded, and the affected items will be updated to refer to the 
replacement families and styles. When you subsequently save the project, the edits 
made are permanently saved, so if you e.g. later send it back to the person who 
sent it to you, it’ll now very likely show the Missing Fonts dialog on their system. 
(STEAM-9209) 

Trills 

Auxiliary notes. Dorico no longer hides auxiliary notes for trills when they describe 
an interval of a diminished second; instead it only hides them when the interval is a 
perfect unison. (STEAM-9620) 

Doubly-diminished intervals. Under rare circumstances it is necessary to describe 
a trill interval to be played on a harp as a doubly-diminished third instead of a major 
second. The Trill interval property now allows you to choose a doubly-diminished 
interval. Use this power wisely. (STEAM-9636) 

VST Expression Maps 

Mutual exclusion for playing techniques. It is now possible to define groups of 
playing techniques in VST Expression Maps that are mutually exclusive, i.e. when a 
playing technique is chosen, any other playing techniques that might already be in 
force that are found in the same mutual exclusion group will be removed. By way of 
example: in most virtual instruments and sample libraries (though not necessarily 
for real musicians), the string techniques pizzicato and arco are mutually exclusive, 
i.e. it is not possible to play both plucked and bowed at the same time; similarly, for 
virtual or sampled brass instruments, the various kinds of mute, such as harmon 
mute and bucket mute, can also not be used at the same time. 

Previous versions of Dorico applied a couple of simple default mutual exclusion 
groups to handle these kinds of common cases, but now you can define your own 
groups in the Play ▶ Expression Maps dialog. In the Techniques section you will 
see on the left a list of mutual exclusion groups defined for the selected VST 
Expression Map, and on the right a list of the playing techniques included in that 
group. 

To add a new group, click the + button in the action bar below the left-hand 
Mutual exclusion groups list, and then give the new group a name of your choice. 
To add techniques to the group, click the + button in the action bar below the 
right-hand Has techniques list, then choose the techniques to be added from the 
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dialog that appears; you can select multiple techniques using Ctrl+click 
(Windows) or Command-click (Mac). (STEAM-6029) 

Secondary volume control. Some sample libraries use both a continuous MIDI 
controller and note velocity to control the dynamic level for sustaining instruments. 
A new Use secondary dynamic option has been added to the Play ▶ Expression 
Maps dialog, allowing you to define an additional volume mechanism for each VST 
Expression Map. (STEAM-9376) 

Changing channels in VST Expression Maps. Some sample libraries split different 
playing techniques and articulations between separate patches that must be 
loaded into separate slots or channels of a multi-timbral VST instrument. In order to 
create a VST Expression Map that can access all of these techniques, it is now 
possible to specify that switching to a particular playing technique requires either 
an absolute or relative channel change. 

An absolute channel change requires you to specify the actual channel number 
where the patch that provides this playing technique is found: to add an absolute 
channel change, click Abs Ch. in the action bar in the Actions section of the 
Expression Maps dialog. 

A relative channel change instead requires you to specify the delta between the 
current channel and the channel where the patch that provides this playing 
technique is found; for example, the pizz. technique might be found on the next 
channel, which is a relative change of 1; while the col legno technique might be 
found on the next but one channel, which is a relative change of 2. To add a 
relative channel change, click Rel. Ch. in the action bar in the Actions section of 
the Expression Maps dialog. (STEAM-9451) 

User interface 

Refined appearance. The dark and light themes for Dorico have been reworked to 
provide greater consistency and greater contrast. In the dark theme, all dialogs now 
have a dark background and light text as well as the main project window, to better 
align with the Dark Mode setting in macOS 10.14 and later; in addition, the title 
bars of dialogs and windows will use the dark appearance when Dorico’s dark 
theme is chosen. 

Voice and selection colors. The color used to show the other items in a linked 
group, when selecting an immediate dynamic grouped with a gradual dynamic, has 
been darkened a little, while the colors used for voices have been tweaked to 
provide better contrast between them. (STEAM-9257) 

Undo and redo. The Edit ▶ Undo and Redo menu items are now appended with 
the name of the operation to be undone or redone. (STEAM-9033) 



 

 
Dorico 3 Version History Page 74 Steinberg Media Technologies GmbH 

Installation and licensing 

Running Dorico Pro as Dorico Elements or Dorico LE. If you have a license for 
Dorico Pro but want to run the application with the limitations of Dorico Elements 
or even Dorico LE, you can do this by holding a key down when you start the 
application: hold Alt to run as Dorico Elements, or hold Ctrl (Windows) or 
Command (Mac) to run as Dorico LE. 

Content installer. Dorico now requires only two packages to be installed: the 
Dorico application installer itself, and the appropriate content installer for your 
chosen variant (Dorico Pro, Dorico Elements, or Dorico LE). The content installer 
includes HALion Sonic SE 3.2 and the HALion Sonic SE factory content. For 
Dorico Elements and Dorico Pro, it additionally includes the Soundiron Olympus 
Micro choral sounds. For Dorico Pro only, it additionally includes the HALion 
Symphonic Orchestra content. 

Regardless of whether you are installing Dorico for the first time, are updating from 
a previous version, or are upgrading from Dorico Elements to Dorico Pro, you are 
recommended to run the provided content installer to ensure that all of the 
appropriate content and HALion Sonic SE itself is correctly installed. 

Time-limited licenses. If you are using a time-limited license – for example, a 30-
day trial license or a 1-year Dorico Pro 365 license – you can now see the expiry 
date of your license at any time in the About Dorico window (in the Help menu on 
Windows, and in the Dorico menu on Mac). If your license is time-limited, the 
expiry date or number of days remaining is shown at the bottom of the window; if 
your license is not time-limited, no expiry information will appear there. 

Platform support 

Deleting files. When Dorico deletes auto-saves, backup projects, key commands, 
etc., these files are all now moved to the Recycle Bin (Windows) or Trash (Mac) 
rather than being deleted immediately. (STEAM-9360) 

Minimum supported operating system. Dorico now requires macOS 10.12 Sierra 
or later. 
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Issues resolved 
ID # Component Issue 

STEAM-9074 Articulations 
Inputting an articulation on a single note in chord mode no longer incorrectly also adds the 
same articulation to the next note in that voice. 

STEAM-9142 Bar numbers 
Setting the Color property on a bar number now changes the color of the bar number’s 
enclosure, if one is shown. 

STEAM-9364 Bar repeats 
When casting off the music, if both bars of a 2-bar repeat or all four bars of a 4-bar repeat 
do not fit on the system, that whole repetition will no longer be forced onto the system. 

STEAM-9387 Bar repeats 
Enabling consolidation of bar repeats in very large scores no longer sometimes causes 
Dorico to crash. 

STEAM-9188 Barlines 
It is now possible to copy a time signature and all its associated special barlines at the 
same time. 

STEAM-9215 
Chord 
symbols 

Chord symbols whose position coincides with a change from one instrument to another on 
the same system are no longer drawn twice. 

STEAM-9297 Cues Dragging cue labels in Engrave mode now draws the attachment line correctly. 

STEAM-9341 Cues Microtonal accidentals now appear correctly in octave-shifted cues. 

STEAM-9462 Cues 
Dorico no longer draws the cue clef in the preamble if the cue clef matches the default clef 
of the destination instrument. 

STEAM-9744 Cues A problem whereby the wrong clef could be used for a cue has been fixed. 

STEAM-5887 Dynamics 
It was sometimes mysteriously impossible to create a dynamic at a position because an 
empty dynamic group had been left there; these empty groups are now removed. 

STEAM-9202 Dynamics 
Some situations in which replacing a dynamic in an existing group, or appending a dynamic 
to the end of a group, would produce an unwanted extra dynamic have been fixed. 

STEAM-9228 Dynamics 
Under some circumstances, gradual dynamics could move further away from the staff in 
galley view during note input; this problem has now been fixed. 

STEAM-9488 Dynamics Dynamics at the same position that are not part of the same group now play back correctly. 

STEAM-9192 Filters Filter Notes by Pitch now works correctly on divisi staves. 

STEAM-9004 Fingering 
Fingerings on grace notes now correctly respect the Follow voice direction engraving 
option. 

STEAM-4925 
Glissando 
lines 

The snapping of glissando lines when the note at either end of the glissando either 
becomes tied or becomes notated as a single note has been improved. 

STEAM-9464 Grace notes 
Under some circumstances, grace notes in transposed pitch layouts could appear in the 
wrong position on the staff; this problem has now been fixed. 

STEAM-7831 
Graphics 
export 

Text in exported SVG files is no longer too small (Windows only). 
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ID # Component Issue 

STEAM-9117 
Graphics 
export 

Text items in exported PDFs no longer sometimes incorrectly use the stretch value defined 
for a different text item. 

STEAM-9346 
Graphics 
export 

Export All Layouts as PDF no longer incorrectly exports only the first page of each layout. 

STEAM-9362 
Holds and 
pauses 

Under some circumstances, edits to items in the vicinity of a fermata could cause the 
distance between staves to increase unexpectedly; this problem has now been fixed. 

STEAM-9229 
Key 
signatures 

Custom key signatures with per-clef octave overrides for accidentals now display correctly 
in the preamble at the start of each system. 

STEAM-9261 Localization 
Instrument change warning labels now use the language as chosen on the Language page 
of Engraving Options, rather than the language chosen for the application’s interface. 

STEAM-9169 Lyrics 
Under rare circumstances, Dorico could crash when processing lyrics; this problem has 
now been fixed. 

STEAM-9212 MIDI export 
Exporting a project containing a trill after the 374th quarter note (crotchet) beat as a MIDI 
file no longer causes additional unwanted notes to be exported at the start. 

STEAM-9381 MIDI export 
Notes where Playback end offset is set to a large enough negative value that the end of 
the note comes before their start positions are no longer exported to MIDI. 

STEAM-9023 MIDI import 
Drum set music exported from Dorico via MIDI and then reimported is now correctly 
identified as being for drums. 

STEAM-9213 
Multi-bar 
rests 

Dorico no longer crashes when attempting to exclude single-bar multi-bar rests from 
spacing in the presence of local time signatures. 

STEAM-9734 
Multi-bar 
rests 

Dorico will no longer show “tacet al fine” for a multi-bar rest that goes to the end of a flow 
if a repeat marker is positioned at the final barline. 

STEAM-9361 Music fonts 
When changing music font using Engrave ▶ Music Fonts, Dorico now updates all 
notehead sets, rather than only those notehead sets that are used in the project. 

STEAM-5364 Note input 
Selecting an implicit rest and typing . or clicking the dot button in the note input toolbox 
now changes the rest’s duration as expected, rather than doing nothing. 

STEAM-8950 Note input 
It is now possible to navigate the caret left or right across the position where one 
instrument transitions to another in page view. 

STEAM-9197 Note input 
Pasting a selection that ends with non-note items would not always correctly extend the 
flow such that the last non-note item would appear; this problem is now fixed. 

STEAM-9326 Note input 
Glissando lines are no longer sometimes incorrectly overwritten or removed when copying 
and pasting. 

STEAM-9328 Note input 
Under some circumstances, pasting or repeating notes in one voice on a percussion kit 
would incorrectly overwrite music in another voice; this problem is now fixed. 

STEAM-9421 Note input 
Under some circumstances, paste operations (including Reduce and Paste into Voice) 
could cause notes to be incorrectly placed inside tuplets; this problem is now fixed. 

STEAM-9450 Note input 
It is once again possible to invoke the caret at the end of the flow by selecting the 
automatic final barline and typing Return or Shift+N. 
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ID # Component Issue 

STEAM-9514 Note input 
It is now possible to paste material onto an extra staff (e.g. an ossia) belonging to an 
unpitched percussion instrument. 

STEAM-9174 Note spacing 
Edits to system indents made in Engrave mode are now correctly respected for systems 
where the first spaced position comes after the very start of the system. 

STEAM-9036 Notes 
Overriding the Voice column index property for a cross-staff note no longer sometimes 
causes one or more noteheads on the cross-staff stem to become detached. 

STEAM-9245 
STEAM-9334 

Notes 
In general, editing operations that affect the duration of a note no longer remove any 
Forced Duration properties from that note unless absolutely necessary. 

STEAM-9289 Notes 
The Rhythm dot consolidation property now correctly takes precedence over the 
corresponding engraving option, so setting it for a chord will cause it to always take effect. 

STEAM-9477 Notes 
Rhythm dots moved horizontally to avoid note flags now correctly ignore the note-dot gap if 
the note itself is scaled. 

STEAM-9395 Ornaments 
It is once again possible to create an inverted turn in the Shift+O popover by typing 
invturn. 

STEAM-9239 Page layout Wait for next frame break now works as expected if applied to a frame break on a tacet. 

STEAM-9354 Page layout 
Setting Wait for next system/frame break now always works correctly in layouts where 
fixed casting-off, specifically a fixed number of systems per frame, is enabled. 

STEAM-8433 
STEAM-8892 

Performance 
The Mixer window now opens more quickly, and updates more quickly when 
hiding/showing different faders or sections. 

STEAM-9092 Performance The speed of loading sounds in NotePerformer has been increased. 

STEAM-9389 Performance 
Editing music in projects where large time signatures are drawn outside the staff at system 
item positions no longer incurs a performance penalty. 

STEAM-9390 Performance 
Inputting notes in a layout where bar rests are hidden (via Layout Options) is no longer 
much slower than when bar rests are shown as normal. 

STEAM-9502 Performance 
Dorico is now much more resilient to being flooded with MIDI data from external devices, 
so it should no longer exhibit unusually high CPU usage or hang altogether. 

STEAM-9021 Performance 
It is now much faster to change between the different options in View ▶ Note and Rest 
Colors. 

STEAM-9118 Play mode 
Clicking on a note in the piano roll editor with the selection tool no longer sometimes 
incorrectly results in the note being deleted. 

STEAM-9338 Play mode 
Swing is now calculated correctly for irregular or pick-up bars that start midway through a 
beat. 

STEAM-9348 Play mode 
Deleting players in Setup mode no longer causes stale information to be left behind in the 
Endpoint Setup dialog. 

STEAM-9397 Play mode 
Duplicating a plug-in in the VST Instruments rack in Play mode now correctly creates the 
appropriate MIDI channels in the Mixer. 
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ID # Component Issue 

STEAM-9403 Play mode 
Dorico no longer crashes if you attempt to change an instrument to use a different 
playback device in the track header after setting the MIDI channel to an invalid value. 

STEAM-9405 Play mode 
Keyswitches and MIDI controllers are now output in the same order in which they are 
defined in the VST Expression Map. 

STEAM-9410 Play mode The mouse cursor now correctly changes after choosing a different tool in Play mode. 

STEAM-9428 Play mode 
When jumping back to an earlier place in the music from a repeat, the tempo at the 
destination is now correctly chased. 

STEAM-9448 Play mode 
If explicit CC7 or CC10 automation data is present, the initial value from the MIDI fader in 
the Mixer is no longer output in preference to the automation when starting playback. 

STEAM-9290 
Playing 
techniques 

The size of playing techniques now correctly updates immediately according to a change 
of staff size at a system break. 

STEAM-9173 Print mode 
The command Export All Layouts as PDF no longer incorrectly only exports the first page 
of each layout to PDF. 

STEAM-9122 Project files 
Saving an auto-backup no longer causes Dorico to crash if the filename of the project 
being saved contains an unmatched parenthesis. 

STEAM-9643 
Repeat 
markers 

A right-aligned repeat marker positioned at the final barline of the flow no longer incorrectly 
collides with other items positioned within the final bar. 

STEAM-9270 
Rhythm 
slashes 

Dragging the end handle of a slash region that crosses a start or end repeat barline no 
longer sometimes causes a crash. 

STEAM-9475 
Rhythm 
slashes 

Under some circumstances, where rhythm slash regions are present on multiple staves, a 
slash region starting in the middle of a bar would not show correct rests; this is now fixed. 

STEAM-9598 
Rhythm 
slashes 

Rhythm slashes no longer sometimes draw in the “out of range” color for instruments with 
large transpositions. 

 Setup mode 
It is no longer possible to drag an instrument from a solo player and drop it onto a section 
player; section players can only hold a single instrument. 

STEAM-9024 Slurs 
Slur on cross-staff notes no longer fail to draw if a staff has been removed by a staff count 
change. 

STEAM-8776 
STEAM-9264 

Slurs, tuplets 
The positioning of slurs, tuplets and articulations on notes crossed to another staff is now 
correct when extra staves belonging to the instrument are hidden. 

STEAM-9191 Staff labels 
The Show instrument change label at start of flow option is now switched on by default 
in part layouts, and only shows a label if the player holds multiple instruments. 

STEAM-9372 Tempo 
Tempo equations whose width to the left of the barline is greater than the width to the left 
of a coincident rehearsal mark no longer cause staves to unexpectedly be forced apart. 

STEAM-6775 Text 
Lower diacritics are now positioned correctly; this also corrects problems with the vertical 
positioning of ligatures in the Figurato font (Mac only). 

STEAM-9201 Text Stretching fonts now works correctly once more (Mac only). 
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ID # Component Issue 

STEAM-9367 Text 
Text items at grace note positions no longer cause collision avoidance to behave as if the 
text item were in fact positioned at the primary position. 

STEAM-9380 Text 
The positioning of multi-line text items above the staff when the staff itself does not have 
any protruding items has been improved. 

STEAM-9193 
Time 
signatures 

Under some circumstances, typing Return with a barline selected in an open meter could 
cause Dorico to crash; this problem is now fixed. 

STEAM-9115 Tokens 
Tokens for resolving dates that show the day of the month as digits no longer include an 
extra space for single-digit days. 

STEAM-9140 Tremolos 
Resetting the beaming of a single-note tremolo no longer incorrectly causes that note to 
stop playing back. 

STEAM-9178 Tremolos 
Resetting the beaming of notes with two-note tremolos now correctly causes them to play 
back as normal, non-tremolo notes. 

STEAM-9179 Tremolos It is no longer possible to set both a single-note and multi-note tremolo on the same note. 

STEAM-9253 Tremolos Clearing tremolos using the Shift+R popover now redoes correctly when undone. 

STEAM-9337 Tremolos 
Tremolos on up-stem notes on single-line percussion instruments are no longer needlessly 
snapped upwards to avoid staff lines that are not drawn. 

STEAM-9113 User interface 
The status bar read-out for the transposition of the current layout no longer sometimes 
gets out of step with changes in transposition. 

STEAM-9189 User interface 
Dorico will now correctly navigate to the start of a flow when clicking on its card in the 
Flows panel in Setup mode if its first bar number is greater than 1. 

STEAM-9207 User interface 
Navigating left or right through the music in galley view with Home/End no longer 
incorrectly uses the total width of the first flow to determine the amount to move. 

STEAM-9222 User interface 
The Use custom player order control on the Players page of Layout Options is now 
always correctly enabled or disabled as appropriate. 

STEAM-9279 User interface 
Key commands typed while a modal Open or Save dialog is open no longer unexpectedly 
edits the project in the background (Mac only). 

STEAM-9349 User interface 
It is no longer possible to try to switch to galley view when no layout is currently visible in 
the music area. 

STEAM-9368 User interface It is no longer possible to resize the Mixer beyond the maximum size of its displayed faders. 

STEAM-9397 User interface 
When switching to Play mode from Engrave mode, the buttons from the Engrave mode 
toolbox no longer incorrectly appear in the toolbox in Play mode. 

STEAM-9496 User interface 
Clicking one of the buttons in the toolbox in Engrave mode when no layout is currently 
visible in the music area no longer causes Dorico to crash. 
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Known issues and solutions 

Frequently asked questions 
Answers to frequently asked questions about Dorico can be found online in the 
Dorico forum. 

Knowledge base 
For the latest information about issues and solutions you may encounter when 
running Dorico, please consult the Knowledge Base. 

Entering the eLicenser Activation Code (Mac only) 
When you first run Dorico and are prompted to enter your Activation Code, you 
may find that after you have successfully activated your Soft-eLicenser, you must 
quit and restart Dorico for the application to detect that it is fully licensed. 

Key commands to transpose notes by an octave (Windows only) 
The Intel Graphics Adaptor drivers used by many Windows computers define a 
default key command to flip the screen by 90, 180 and 270 degrees via a shortcut 
Ctrl+Alt+up/down/left/right arrows. 

Ctrl+Alt+up/down option conflicts with the key commands in Dorico note input for 
transposing notes by an octave. 

For information about how to disable the default Intel Graphics Adaptor key 
command, consult the Knowledge Base. 

https://www.dorico.com/forum
https://helpcenter.steinberg.de/hc
https://helpcenter.steinberg.de/hc



